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Preface

Welcome to the IAR Assembler User Guide for Arm. The purpose of this guide is
to provide you with detailed reference information that can help you to use
the IAR Assembler for Arm to develop your application according to your
requirements.

Who should read this guide

You should read this guide if you plan to develop an application, or part of an
application, using assembler language for the Arm core, and need to get detailed
reference information on how to use the IAR Assembler for Arm. In addition, you
should have working knowledge of the following:

o The architecture and instruction set of the Arm core (refer to the chip
manufacturer’s documentation)

o General assembler language programming

o Application development for embedded systems

o The operating system of your host computer.

How to use this guide

When you first begin using the IAR Assembler for Arm, you should read the chapter
Introduction to the IAR Assembler for Arm.

If you are an intermediate or advanced user, you can focus more on the reference
chapters that follow the introduction.

If you are new to using IAR Embedded Workbench, we suggest that you first go through
the tutorials, which you can find in IAR Information Center in the product, under
Product Explorer. They will help you get started.
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What this guide contains

Below is a brief outline and summary of the chapters in this guide.

Introduction to the IAR Assembler for Arm provides programming information. It
also describes the source code format, and the format of assembler listings.

Assembler options first explains how to set the assembler options from the
command line and how to use environment variables. It then gives an alphabetical
summary of the assembler options, and contains detailed reference information
about each option.

Assembler operators gives a summary of the assembler operators, arranged in order
of precedence, and provides detailed reference information about each operator.

Assembler directives gives an alphabetical summary of the assembler directives, and
provides detailed reference information about each of the directives, classified into
groups according to their function.

Assembler pseudo-instructions lists the pseudo-instructions that are accepted by the
IAR Assembler for Arm.

Assembler diagnostics contains information about the formats and severity levels of
diagnostic messages.

Migrating to the IAR Assembler for Arm contains information that is useful when
migrating from an existing product to the IAR Assembler for Arm.

Other documentation

IAR Assembler User Guide
for Arm

User documentation is available as hypertext PDFs and as a context-sensitive online
help system in HTML format. You can access the documentation from the IAR
Information Center or from the Help menu in the IAR Embedded Workbench IDE. The
online help system is also available via the F1 key.

USER AND REFERENCE GUIDES

The complete set of IAR development tools is described in a series of guides.
Information about:

System requirements and information about how to install and register the IAR
products are available in the Installation and Licensing Quick Reference Guide and
the Licensing Guide.

Using the IDE for project management and building, is available in the /DE Project
Management and Building Guide for Arm.

Using the IAR C-SPY® Debugger and C-RUN runtime error checking, is available
in the C-SPY® Debugging Guide for Arm.
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o Programming for the IAR C/C++ Compiler for Arm and linking, is available in the
1IAR C/C++ Development Guide for Arm.

o Programming for the AR Assembler for Arm, is available in the /AR Assembler
User Guide for Arm.

o Performing a static analysis using C-STAT and the required checks, is available in
the C-STAT® Static Analysis Guide.

o Using I-jet, refer to the AR Debug Probes User Guide for I-jet®, I-jet Trace, and
I-scope.

o Using IAR J-Link and IAR J-Trace, refer to the J-Link/J-Trace User Guide.

e Porting application code and projects created with a previous version of the IAR
Embedded Workbench for Arm, is available in the /AR Embedded Workbench®
Migration Guide.

Note: Additional documentation might be available depending on your product
installation.

THE ONLINE HELP SYSTEM
The context-sensitive online help contains information about:

IDE project management and building
Debugging using the IAR C-SPY® Debugger
The IAR C/C++ Compiler and Linker

The IAR Assembler

C-STAT

Document conventions

When, in the IAR documentation, we refer to the programming language C, the text also
applies to C++, unless otherwise stated.

When referring to a directory in your product installation, for example arm\doc, the full
path to the location is assumed, for example c: \Program Files\IAR
Systems\Embedded Workbench N.n\arm\doc, where the initial digit of the version
number reflects the initial digit of the version number of the IAR Embedded Workbench
shared components.
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TYPOGRAPHIC CONVENTIONS

The IAR documentation set uses the following typographic conventions:

Style Used for
computer * Source code examples and file paths.
* Text on the command line.
* Binary, hexadecimal, and octal numbers.

parameter A placeholder for an actual value used as a parameter, for example
filename.h where filename represents the name of the file.

[option] An optional part of a linker or stack usage control directive, where [
and ] are not part of the actual directive, butany [, 1, {, or } are part
of the directive syntax.

{option} A mandatory part of a linker or stack usage control directive, where {
and } are not part of the actual directive, but any [, ], {, or } are part
of the directive syntax.

[option] An optional part of a command line option, pragma directive, or library
filename.

[a|b]|c] An optional part of a command line option, pragma directive, or library
filename with alternatives.

{a|b]|c} A mandatory part of a command line option, pragma directive, or
library filename with alternatives.

bold Names of menus, menu commands, buttons, and dialog boxes that
appear on the screen.

italic * A cross-reference within this guide or to another guide.

* Emphasis.

An ellipsis indicates that the previous item can be repeated an arbitrary
number of times.

Identifies instructions specific to the IAR Embedded Workbench® IDE
interface.

Identifies instructions specific to the command line interface.

Identifies helpful tips and programming hints.

Identifies warnings.

Table 1: Typographic conventions used in this guide
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NAMING CONVENTIONS

The following naming conventions are used for the products and tools from IAR, when
referred to in the documentation:

Brand name Generic term

IAR Embedded Workbench® for Arm IAR Embedded Workbench®
IAR Embedded Workbench® IDE for Arm the IDE

IAR C-SPY® Debugger for Arm C-SPY, the debugger

IAR C-SPY® Simulator the simulator

IAR C/C++ Compiler™ for Arm the compiler

IAR Assembler™ for Arm the assembler

IAR ILINK Linker™ ILINK, the linker

IAR DLIB Runtime Environment™ the DLIB runtime environment

Table 2: Naming conventions used in this guide

In 32-bit mode refers to using IAR Embedded Workbench for Arm configured for the
instruction sets T32/T and A32.

In 64-bit mode refers to using IAR Embedded Workbench for Arm configured for the
instruction set A64.

For more information, see Execution modes, page 24.
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Introduction to the IAR
Assembler for Arm

e Introduction to assembler programming
e Modular programming

e External interface details

e Source format

e Assembler instructions

e Execution modes

e Expressions, operands, and operators

e List file format

e Programming hints

e Tracking call frame usage

Introduction to assembler programming
Even if you do not intend to write a complete application in assembler language, there
might be situations where you find it necessary to write parts of the code in assembler,
for example, when using mechanisms in the Arm core that require precise timing and
special instruction sequences.

To write efficient assembler applications, you should be familiar with the architecture
and instruction set of the Arm core. Refer to the Arm Limited hardware documentation
for syntax descriptions of the instruction mnemonics.

GETTING STARTED
To ease the start of the development of your assembler application, you can:

o Work through the tutorials—especially the one about mixing C and assembler
modules—that you find in the Information Center, under Product Explorer
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o Read about the assembler language interface—also useful when mixing C and
assembler modules—in the /AR C/C++ Development Guide for Arm

o In the IAR Embedded Workbench IDE, you can base a new project on a template
for an assembler project.

Modular programming

IAR Assembler User Guide
for Arm

Itis widely accepted that modular programming is a prominent feature of good software
design. If you structure your code in small modules—in contrast to one single
monolith—you can organize your application code in a logical structure, which makes
the code easier to understand, and which aids:

e efficient program development
e reuse of modules

@ maintenance.

The IAR development tools provide different facilities for achieving a modular structure
in your software.

Typically, you write your assembler code in assembler source files—each file becomes
a named module. If you divide your source code into many small source files, you will
get many small modules. You can divide each module further into different subroutines.

A section is a logical entity containing a piece of data or code that should be mapped to
a physical location in memory. Use the section control directives to place your code and
data in sections. A section is relocatable. An address for a relocatable section is resolved
at link time. Sections enable you to control how your code and data is placed in memory.
A section is the smallest linkable unit, which allows the linker to include only those units
that are referred to.

If you are working on a large project you will soon accumulate a collection of useful
routines that are used by several of your applications. To avoid ending up with a huge
amount of small object files, collect modules that contain such routines in a library
object file. Note that a module in a library is always conditionally linked. In the IAR
Embedded Workbench IDE, you can set up a library project, to collect many object files
in one library. For an example, see the tutorials in the Information Center.

To summarize, your software design benefits from modular programming, and to
achieve a modular structure you can:
o Create many small modules, one per source file

e In each module, divide your assembler source code into small subroutines
(corresponding to functions on the C level)
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e Divide your assembler source code into sections, to gain more precise control of
how your code and data finally is placed in memory

o Collect your routines in libraries, which means that you can reduce the number of
object files and make the modules conditionally linked.

External interface details
This section provides information about how the assembler interacts with its
environment:
® Assembler invocation syntax, page 21
® Passing options, page 22
® Environment variables, page 22
® Error return codes, page 22
You can use the assembler either from the AR Embedded Workbench IDE or from the

command line. Refer to the /DE Project Management and Building Guide for Arm for
information about using the assembler from the IAR Embedded Workbench IDE.

ASSEMBLER INVOCATION SYNTAX
The invocation syntax for the assembler is:

iasmarm [options] [sourcefile] [options]

For example, when assembling the source file prog . s, use this command to generate an
object file with debug information:

iasmarm prog -r

By default, the IAR Assembler for Arm recognizes the filename extensions s, asm, and
msa for source files. The default filename extension for assembler output is o.

Generally, the order of options on the command line, both relative to each other and to
the source filename, is not significant. However, there is one exception—when you use
the -1 option—the directories are searched in the same order that they are specified on
the command line.

If you run the assembler from the command line without any arguments, the assembler
version number and all available options, including brief descriptions, are directed to
stdout and displayed on the screen.

21
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PASSING OPTIONS
You can pass options to the assembler in three different ways:

e Directly from the command line

Specity the options on the command line after the iasmarm command, see
Assembler invocation syntax, page 21.

e Via environment variables

The assembler automatically appends the value of the environment variables to every
command line, so it provides a convenient method of specifying options that are
required for every assembly, see Environment variables, page 22.

e Via a text file by using the - £ option, see -f, page 56.

For general guidelines for the option syntax, an options summary, and more information
about each option, see the Assembler options chapter.

ENVIRONMENT VARIABLES
You can use these environment variables with the AR Assembler:

Environment variable Description

IASMARM Specifies command line options, for example:
set IASMARM=-L -ws

IASMARM_INC Specifies directories to search for include files, for example:
set IASMARM_INC=c:\myinc\

Table 3: Assembler environment variables

For example, setting this environment variable always generates a list file with the name
temp.lst:

set IASMARM=-1 temp.lst

For information about the environment variables used by the compiler and linker, see the
IAR C/C++ Development Guide for Arm.

ERROR RETURN CODES

When using the IAR Assembler from within a batch file, you might have to determine
whether the assembly was successful to decide what step to take next. For this reason,
the assembler returns these error return codes:

Return code Description
0 Assembly successful, warnings might appear.
1 Warnings occurred (only if the —~ws option is used).

Table 4: Assembler error return codes
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Return code Description
2 Errors occurred.
3 Fatal errors occurred (making the assembler abort).

Table 4: Assembler error return codes (Continued)

Source format

The format of an assembler source line is as follows:

[label [:]] [operation] [operands] [; comment]

where the components are as follows:

label A definition of a label, which is a symbol that represents

an address. If the label starts in the first column—that is, at
the far left on the line—the : (colon) is optional.

operation An assembler instruction or directive. This must not start
in the first column—there must be some whitespace to the
left of it.

operands An assembler instruction or directive can have zero, one,

or more operands. The operands are separated by commas.
comment Comment, preceded by a ; (semicolon)

C or C++ comments are also allowed.

The components are separated by spaces or tabs.
A source line cannot exceed 2,047 characters.

Tab characters, ASCII 09H, are expanded according to the most common practice, that
is, to columns 8, 16, 24 etc. This affects the source code output in list files and debug
information. Because tabs might be set up differently in different editors, do not use tabs
in your source files.

Assembler instructions

The IAR Assembler for Arm supports the syntax for assembler instructions as described
in the ARM Architecture Reference Manual. It complies with the requirement of the Arm
architecture on word alignment. Any instructions in a code section placed on an odd
address results in an error.
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Execution modes

IAR Embedded Workbench for Arm supports the 32-bit and 64-bit Arm architectures by
means of execution modes.

In 32-bit mode refers to using IAR Embedded Workbench for Arm configured to
generate and debug code for the T32/T and A32 instruction sets, either on an
Armv4/5/6/7 core or in the AArch32 execution state on an Arm v8-A core. In 32-bit
mode, you can use both the A32 and T32/T instruction sets and switch between them.

In 64-bit mode refers to using IAR Embedded Workbench for Arm configured to
generate and debug code for the A64 instruction set in the AArch64 execution state on
an Arm v8-A core. Code in 64-bit mode can call code in 32-bit mode, and that code can
return back. However, the IAR translator tools do not support this switch being used in
a single linked image. Switching between A32/T32/T code and A64 code must be
performed by using several images. For example, an OS using 64-bit mode can start
applications in either 64-bit or in 32-bit mode.

The AArch32 execution state is compatible with the Arm v7 architecture. The AArch32
execution state is emulated inside the AArch64 execution state.

Expressions, operands, and operators

IAR Assembler User Guide
for Arm

Expressions consist of expression operands and operators.

The assembler accepts a wide range of expressions, including both arithmetic and
logical operations. All operators use 64-bit two’s complement integers. Range checking
is performed if a value is used for generating code.

Expressions are evaluated from left to right, unless this order is overridden by the
priority of operators. See also Assembler operators.

These operands are valid in an expression:

e Constants for data or addresses, excluding floating-point constants

o Symbols—symbolic names—which can represent either data or addresses, where
the latter also is referred to as labels

o The program location counter (PLC), . (period).
The operands are described in greater details on the following pages.

Note: You cannot have two symbols in one expression, or any other complex
expression, unless the expression can be resolved at assembly time. If they are not
resolved, the assembler generates an error.
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INTEGER CONSTANTS

The assembler uses 64-bit two’s complement internal arithmetic, so integers have a
(signed) range from 2931 10 2631,

Constants are written as a sequence of digits with an optional preceding - (minus) sign
in front to indicate a negative number.

Commas and decimal points are not permitted.

The following types of number representation are supported:

Integer type Example

Binary 1010b,b'1010

Octal 1234q, g'1234

Decimal 1234,-1,d'1234
Hexadecimal OFFFFh, OXFFFF, h' FFFF

Table 5: Integer constant formats

Note: Both the prefix and the suffix can be written with either uppercase or lowercase
letters.

ASCII CHARACTER CONSTANTS

ASCII constants can consist of any number of characters enclosed in single or double
quotes. Only printable characters and spaces can be used in ASCII strings. If the quote
character itself will be accessed, two consecutive quotes must be used:

Format Value

'ABCD' ABCD (four characters)

"ABCD" ABCD'\O0"' (five characters the last ASCII null)
'A''B!' A'B

T NER %

"1 (4 quotes) '

"' (2 quotes) Empty string (no value)

"" (2 double quotes)

"\0" (an ASCII null character)

\! ', for quote within a string, asin 'I\'d love to'
\\ \, for \ within a string
A\ ", for double quote within a string

Table 6: ASCII character constant formats
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FLOATING-POINT CONSTANTS

The IAR Assembler accepts floating-point values as constants and converts them into
IEEE half-precision (16-bit), single-precision (32-bit) or double-precision (64-bit)
floating-point format, or fractional format.

Floating-point numbers can be written in the format:
[+|-1[digits].[digits] [{E|e}[+|-1digits]

This table shows valid examples:

Format Value

10.23 1.023 x 10!
1.23456E-24 1.23456 x 1024
1.0E3 1.0x 103

Table 7: Floating-point constants
Spaces and tabs are not allowed in floating-point constants.

Note: Floating-point constants do not give meaningful results when used in expressions.

TRUE AND FALSE
In expressions, a zero value is considered false, and a non-zero value is considered true.

Conditional expressions return the value O for false and 1 for true.

SYMBOLS

User-defined symbols can be up to 32,000 characters long, and all characters are
significant. Depending on what kind of operation a symbol is followed by, the symbol
is either a data symbol or an address symbol where the latter is referred to as a label. A
symbol before an instruction is a label and a symbol before, for example the EQU
directive, is a data symbol. A symbol can be:

e absolute—its value is known by the assembler

o relocatable—its value is resolved at link time.

Symbols must begin with a letter, a—z or A—Z, ? (question mark), or _ (underscore).
Symbols can include the digits 0-9 and $ (dollar).

Symbols may contain any printable characters if they are quoted with * (backquote), for
example:

‘strange#label’

Case is insignificant for built-in symbols like instructions, registers, operators, and
directives. For user-defined symbols, case is by default significant but can be turned on
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and off using the Case sensitive user symbols (-s) assembler option. For more
information, see -s, page 65.

Use the symbol control directives to control how symbols are shared between modules.
For example, use the PUBLIC directive to make one or more symbols available to other
modules. The EXTERN directive is used for importing an untyped external symbol.

Note that symbols and labels are byte addresses. See also Data definition or allocation
directives, page 126.
LABELS

Symbols used for memory locations are referred to as labels.

Program location counter (PLC)

The assembler keeps track of the start address of the current instruction. This is called
the program location counter.

To refer to the program location counter in your assembler source code, use the .
(period) character. For example:

section MYCODE:CODE(2)

arm
b . ; Loop forever
end

REGISTER SYMBOLS

This table shows the predefined register symbols available in 32-bit mode:

Name Size Description

CPSR 32 bits Current program status register

D0-D31 64 bits Floating-point coprocessor registers for double precision

FPCXT 32 bits Floating-point context payload

FPEXC 32 bits Floating-point coprocessor, exception register

FPSCR 32 bits Floating-point coprocessor, status and control register

FPSID 32 bits Floating-point coprocessor, system ID register

Q0-Q15 128 bits Advanced SIMD registers

RO-R12 32 bits General purpose registers

R13 (SP) 32 bits Stack pointer

R14 (LR) 32 bits Link register

R15 (PC) 32 bits Program counter

Table 8: Predefined register symbols in 32-bit mode
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Name Size Description
S0-s31 32 bits Floating-point coprocessor registers for single precision
SPSR 32 bits Saved program status register

Table 8: Predefined register symbols in 32-bit mode (Continued)

In addition, specific cores might allow you to use other registers, for example APSR for
the Cortex-M3, if available in the instruction syntax.

This table shows the predefined register symbols available in 64-bit mode:

Name Size Description

X0-X30 64 bits 64 bits in 64-bits general purpose registers R0-R30

WO-W30 32 bits 32 bits in 64-bits general purpose registers R0-R30

SP 64 bits Stack pointer

WSP 32 bits Stack pointer

Vv0-Vv31 128 bits 128-bit SIMD and floating-point registers V0-V31

00-031 128 bits 128-bit entity in 128-bit SIMD and floating-point registers
v0-v31

D0-D31 64 bits Double-precision floating-point in 128-bit SIMD and
floating-point registers VO-V31

S0-s31 32 bits Single-precision floating-point in 128-bit SIMD and
floating-point registers VO-V31

HO-H31 16 bits Half-precision floating-point in 128-bit SIMD and
floating-point registers V0-v31

B0O-B31 8 bits 8-bit entity in 128-bit SIMD and floating-point registers
vVO0-v31

IPO 64 bits First intra-procedure-call scratch register, alias to R16

IP1l 64 bits Second intra-procedure-call scratch register, alias to R17

FP 64 bits Frame pointer, alias to R29

LR 64 bits Link register, alias to R30

XZR 64 bits Zero 64-bit register

WZR 32 bits Zero 32-bit register

Table 9: Predefined 64-bit register symbols in 64-bit mode

PREDEFINED SYMBOLS

The IAR Assembler for Arm defines a set of symbols for use in assembler source files.
The symbols provide information about the current assembly, allowing you to test them
in preprocessor directives or include them in the assembled code.

IAR Assembler User Guide
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These predefined symbols are available:

Symbol

Value

__aarché64d_ _

__ARM_32BIT_STATE

__ARM_64BIT_STATE

__ARM_ADVANCED_SIMD_ _

__ARM_ARCH

__ARM_ARCH_ISA_A64

__ARM_ARCH_ISA_ARM

__ARM_ARCH_ISA_THUMB

__ARM_ARCH_PROFILE

_ARM_BIG_ENDIAN

__ARM_FEATURE_AES

__ARM_FEATURE_CLZ

__ARM_FEATURE_CMSE

This symbol is defined to 1 when assembling for the A64
instruction set in the AArché4 state.

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

An integer that is set based on the --cpu option. The
symbol is set to 1 if the selected processor architecture has
the Advanced SIMD architecture extension. The symbol is
undefined for other cores.

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

An integer that is set based on the assembler option
--cpu and --cmse. The symbol is set to 3 if the selected
processor architecture has CMSE (Cortex-M security

extensions) and the assembler option --cmse is specified.

The symbol is set to 1 if the selected processor
architecture has CMSE and the assembler option --cmse
is not specified.

The symbol is undefined for cores without CMSE.

Table 10: Predefined symbols
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Symbol

Value

__ARM_FEATURE_CRC32

__ARM_FEATURE_CRYPTO

__ARM_FEATURE_DIRECTED_
ROUNDING

__ARM_FEATURE_DSP

__ARM_FEATURE_FMA

__ARM_FEATURE_FP16_FML

__ARM_FEATURE_IDIV

__ARM_FEATURE_NUMERIC_M
AXMIN

__ARM_FEATURE_QBIT

__ARM_FEATURE_QRDMX

__ARM_FEATURE_SAT

__ARM_FEATURE_SHA2

__ARM_FEATURE_SHA3

This symbol is defined to 1 if the CRC32 instructions are
supported (optional in Armv8-A/R).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined to 1 if the cryptographic instructions
are supported (implies Armv8-A/R with Neon).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined to 1 if the directed rounding and
conversion instructions are supported.

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined to 1 if the FPU supports fused
floating-point multiply-accumulate.

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined to 1 if the floating-point numeric
maximum and minimum instructions are supported.
This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

Table 10: Predefined symbols (Continued)
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Value

__ARM_FEATURE_SHAS512

__ARM_FEATURE_SIMD32

__ARM_FEATURE_SM3

__ARM_FEATURE_SM4

__ARM_FP

__ARM_MEDIA__

__ARM_MPCORE_ _

__ARM_NEON

__ARM_NEON_FP

__ARM_PROFILE_M__

__ARMVFP_ _

__ARMVFP_D16__

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

An integer that is set based on the —-cpu option. The
symbol is set to 1 if the selected processor architecture has
the ARMvé6 SIMD extension for multimedia. The symbol is
undefined for other cores.

An integer that is set based on the --cpu option. The
symbol is set to 1 if the selected processor architecture has
the Multiprocessing Extensions. The symbol is undefined
for other cores.

This symbol is defined according to the Arm C Language
Extensions (ACLE).

This symbol is defined according to the Arm C Language
Extensions (ACLE).

An integer that is set based on the --cpu option. The
symbol is set to 1 if the selected processor is a profile M
core. The symbol is undefined for other cores.

An integer that is set based on the —--fpu option and that
identifies whether floating-point instructions for a vector
floating-point coprocessor have been enabled or not. The
symbol is defined to __ARMVFPV2__, _ARMVFPV3__,
or __ARMVFPV4__. These symbolic names can be used
when testing the __ARMVFP__ symbol. If floating-point

instructions are disabled (default), the symbol is undefined.

An integer that is set based on the assembler option
--fpu. The symbol is set to 1 if the selected FPU is a
VFPv3 or VFPv4 unit with only 16 D registers. Otherwise,
the symbol is undefined.

Table 10: Predefined symbols (Continued)
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Symbol

Value

__LP64_

_TID_

__ARMVFP_FPl6__

__ARMVFP_SP__

_ _BUILD_NUMBER_ _

__CORE_ _

__DATE_ _
__FILE__

__TIAR_SYSTEMS_ASM___

__IASMARM_ _

__TLP32__

__LINE__

__LITTLE_ENDIAN___

An integer that is set based on the assembler option
--fpu. The symbol is set to 1 if the selected FPU only
supports |6-bit floating-point numbers. Otherwise, the
symbol is undefined.

An integer that is set based on the assembler option
--fpu. The symbol is set to 1 if the selected FPU only
supports 32-bit single-precision. Otherwise, the symbol is
undefined.

A unique integer that identifies the build number of the
assembler currently in use. The build number does not
necessarily increase with an assembler that is released later.

An integer that identifies the chip core in use. The value
reflects the setting of the assembler option —--cpu. For
information about the possible values, see the IAR C/C++
Development Guide for Arm.

The current date in dd/Mmm/yyyy format (string).
The name of the current source file (string).

IAR assembler identifier (number). Note that the number
could be higher in a future version of the product. This
symbol can be tested with #ifdef to detect whether the
code was assembled by an assembler from IAR.

An integer that is set to 1 when the code is assembled with
the IAR Assembler for Arm.

This symbol is defined to 1 when assembling for the A64
instruction set in the AArché4 state, using the ILP32 data
model. It can also be written in lower case: __11p32_ _.

The current source line number (number).

Identifies the byte order in use. Expands to the number |
when the code is compiled with the little-endian byte order,
and to the number 0 when big-endian code is generated.
Little-endian is the default.

This symbol is defined to 1 when assembling for the A64
instruction set in the AArché4 state, using the LP64 data
model. It can also be written in lower case: __1p64_ _.

Target identity, consisting of two bytes (number). The high
byte is the target identity, which is 0x4F (=decimal 79) for
the IAR Assembler for Arm.

Table 10: Predefined symbols (Continued)
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Symbol Value
__TIME__ The current time in hh:mm: ss format (string).
__VER__ The version number in integer format, for example, version

6.21.2 is returned as 6021002 (number).
Table 10: Predefined symbols (Continued)

Including symbol values in code

Several data definition directives make it possible to include a symbol value in the code.
These directives define values or reserve memory. To include a symbol value in the code,
use the symbol in the appropriate data definition directive.

For example, to include the time of assembly as a string for the program to display:

name timeOfAssembly
extern printStr
section MYCODE:CODE(2)

adr r0, time ; Load address of time
; string in RO.
bl printStr ; Call string output routine.
bx 1r ; Return
data ; In data mode:
time dc8 __TIME__ ; String representing the

; time of assembly.
end
Testing symbols for conditional assembly

To test a symbol at assembly time, use one of the conditional assembly directives. These
directives let you control the assembly process at assembly time.

For example, if you want to assemble separate code sections depending on whether you
are using an old assembler version or a new assembler version, do as follows:

#if (__VER__ > 6021000) ; New assembler version
#else ; 0ld assembler version
#endif

For more information, see Conditional assembly directives, page 106.
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ABSOLUTE AND RELOCATABLE EXPRESSIONS

Depending on what operands an expression consists of, the expression is either absolute
or relocatable. Absolute expressions are those expressions that only contain absolute
symbols or relocatable symbols that cancel each other out.

Expressions that include symbols in relocatable sections cannot be resolved at assembly
time, because they depend on the location of sections. These are referred to as
relocatable expressions.

Such expressions are evaluated and resolved at link time, by the IAR ILINK Linker.
They can only be built up out of a maximum of one symbol reference and an offset after
the assembler has reduced it.

For example, a program could define absolute and relocatable expressions as follows:

name simpleExpressions
section MYCONST:CONST (2)
first dc32 5 ; A relocatable label.
second equ 10 + 5 ; An absolute expression.
dc32 first ; Examples of some legal
dc32 first + 1 ; relocatable expressions.
dc32 first + second
end

Note: At assembly time, there is no range check. The range check occurs at link time
and, if the values are too large, there is a linker error.
EXPRESSION RESTRICTIONS

Expressions can be categorized according to restrictions that apply to some of the
assembler directives. One such example is the expression used in conditional statements
like TF, where the expression must be evaluated at assembly time, and therefore cannot
contain any external symbols.

The following expression restrictions are referred to in the description of each directive
they apply to.

No forward

All symbols referred to in the expression must be known, no forward references are
allowed.

No external

No external references in the expression are allowed.
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Absolute

The expression must evaluate to an absolute value, a relocatable value (section offset) is
not allowed.

Fixed

The expression must be fixed, which means that it must not depend on variable-sized
instructions. A variable-sized instruction is an instruction that might vary in size
depending on the numeric value of its operand.

List file format

The format of an assembler list file is as follows:

HEADER

The header section contains product version information, the date and time when the file
was created, and which options were used.

BODY

The body of the listing contains the following fields of information:

o The line number in the source file. Lines generated by macros, if listed, have a .
(period) in the source line number field.

o The address field shows the location in memory, which can be absolute or relative
depending on the type of section. The notation is hexadecimal.

o The data field shows the data generated by the source line. The notation is
hexadecimal. Unresolved values are represented by ..... (periods), where two periods
signify one byte. These unresolved values are resolved during the linking process.

® The assembler source line.

SUMMARY

The end of the file contains a summary of errors and warnings that were generated.

SYMBOL AND CROSS-REFERENCE TABLE

When you specify the Include cross-reference option, or if the LSTXRF+ directive was
included in the source file, a symbol and cross-reference table is produced.
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This information is provided for each symbol in the table:

Information Description

Symbol The symbol’s user-defined name.

Mode ABS (Absolute), or REL (Relocatable).

Sections The name of the section that this symbol is defined relative to.
Value/Offset The value (address) of the symbol within the current module, relative to

the beginning of the current section.

Table 11: Symbol and cross-reference table

Programming hints
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This section gives hints on how to write efficient code for the IAR Assembler. For
information about projects including both assembler and C or C++ source files, see the
IAR C/C++ Development Guide for Arm.

ACCESSING SPECIAL FUNCTION REGISTERS

Specific header files for a number of Arm devices are included in the IAR product
package, in the arm\ inc directory. These header files define the processor-specific
special function registers (SFRs) and in some cases the interrupt vector numbers.

Example

The UART read address 0x40050000 of the device is defined in the ionuc100.h file
as:

_TO_REG32_BIT(UAO_RBR, 0x40050000 READ_WRITE uart_rbr_bits)

— [— [p—

The declaration is converted by macros defined in the file io_macros.h to:

UAO_RBR DEFINE 0x40050000

USING C-STYLE PREPROCESSOR DIRECTIVES

The C-style preprocessor directives are processed before other assembler directives.
Therefore, do not use preprocessor directives in macros, and do not mix them with
assembler-style comments. For more information about comments, see Assembler
control directives, page 129.

C-style preprocessor directives like #define are valid in the remainder of the source
code file, while assembler directives like EQU only are valid in the current module.
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Tracking call frame usage

In this section, these topics are described:

o Call frame information overview, page 37

o Call frame information in more detail, page 38
These tasks are described:

Defining a names block, page 38

Defining a common block, page 40

Annotating your source code within a data block, page 40
Specifying rules for tracking resources and the stack depth, page 41
Using CFI expressions for tracking complex cases, page 43

Stack usage analysis directives, page 44

Examples of using CFI directives, page 44

For reference information, see:

Call frame information directives for names blocks, page 133
Call frame information directives for common blocks, page 134

Call frame information directives for data blocks, page 135

Call frame information directives for tracking resources and CFAs, page 136

Call frame information directives for stack usage analysis, page 139

CALL FRAME INFORMATION OVERVIEW

Call frame information (CFI) is information about the call frames. Typically, a call
frame contains a return address, function arguments, saved register values, compiler
temporaries, and local variables. Call frame information holds enough information
about call frames to support two important features:

o C-SPY can use call frame information to reconstruct the entire call chain from the
current PC (program counter) and show the values of local variables in each function
in the call chain. This information is used, for example, in the Call Stack window.

o Call frame information can be used, together with information about possible calls
for calculating the total stack usage in the application. Note that this feature might
not be supported by the product you are using.

The compiler automatically generates call frame information for all C and C++ source
code. Call frame information is also typically provided for each assembler routine in the
system library. However, if you have other assembler routines and want to enable C-SPY
to show the call stack when executing these routines, you must add the required call

frame information annotations to your assembler source code. Stack usage can also be
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handled this way (by adding the required annotations for each function call), but you can
also specity stack usage information for any routines in a stack usage control file (see
the IAR C/C++ Development Guide for Arm), which is typically easier.

CALL FRAME INFORMATION IN MORE DETAIL

You can add call frame information to assembler files by using c£i directives. You can
use these to specity:

o The start address of the call frame, which is referred to as the canonical frame
address (CFA). There are two different types of call frames:

o On a stack—stack frames. For stack frames the CFA is typically the value of the
stack pointer after the return from the routine.

e In static memory, as used in a static overlay system—static overlay frames. This
type of call frame is not required by the Arm core and is therefore not supported.

e How to find the return address.

e How to restore various resources, like registers, when returning from the routine.
When adding the call frame information for each assembler module, you must:
1 Provide a names block where you describe the resources to be tracked.

2 Provide a common block where you define the resources to be tracked and specify
their default values. This information must correspond to the calling convention
used by the compiler.

3 Annotate the resources used in your source code, which in practice means that you
describe the changes performed on the call frame. Typically, this includes
information about when the stack pointer is changed, and when permanent registers
are stored or restored on the stack.

To do this you must define a data block that encloses a continuous piece of source
code where you specify rules for each resource to be tracked. When the descriptive
power of the rules is not enough, you can instead use CF/ expressions.

A full description of the calling convention might require extensive call frame
information. In many cases, a more limited approach will suffice. The recommended
way to create an assembler language routine that handles call frame information
correctly is to start with a C skeleton function that you compile to generate assembler
output. For an example, see the /AR C/C++ Development Guide for Arm.

DEFINING A NAMES BLOCK

A names block is used for declaring the resources available for a processor. Inside the
names block, all resources that can be tracked are defined.
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Start and end a names block with the directives:

CFI NAMES name
CFI ENDNAMES name

where name is the name of the block.
Only one names block can be open at a time.

Inside a names block, four different kinds of declarations can appear—a resource
declaration, a stack frame declaration, a static overlay frame declaration, and a base
address declaration:

o To declare a resource, use one of the directives:

CFI RESOURCE resource : bits
CFI VIRTUALRESOURCE resource : bits

The parameters are the name of the resource and the size of the resource in bits. The
name must be one of the register names defined in the AEABI document that
corresponds to the device architecture, either DWARF for the ARM architecture or
DWARF for the Arm 64-bit architecture (AArch64). A virtual resource is a logical
concept, in contrast to a physical resource such as a processor register. Virtual
resources are usually used for the return address.

To declare more than one resource, separate them with commas.

A resource can also be a composite resource, made up of at least two parts. To declare
the composition of a composite resource, use the directive:

CFI RESOURCEPARTS resource part, part,

The parts are separated with commas. The resource and its parts must have been
previously declared as resources, as described above.

o To declare a stack frame CFA, use the directive:
CFI STACKFRAME cfa resource type

The parameters are the name of the stack frame CFA, the name of the associated
resource (the stack pointer), and the memory type (to get the address space). To
declare more than one stack frame CFA, separate them with commas.

When going back in the call stack, the value of the stack frame CFA is copied into
the associated stack pointer resource to get a correct value for the previous function
frame.

o To declare a base address CFA, use the directive:
CFI BASEADDRESS cfa type

The parameters are the name of the CFA and the memory type. To declare more than
one base address CFA, separate them with commas.

A base address CFA is used for conveniently handling a CFA. In contrast to the stack
frame CFA, there is no associated stack pointer resource to restore.

39



Tracking call frame usage

40

IAR Assembler User Guide
for Arm

DEFINING A COMMON BLOCK

The common block is used for declaring the initial contents of all tracked resources.
Normally, there is one common block for each calling convention used.

Start a common block with the directive:
CFI COMMON name USING namesblock

where name is the name of the new block and namesbIock is the name of a previously
defined names block.

Declare the return address column with the directive:
CFI RETURNADDRESS resource type

where resource is a resource defined in namesblock and type is the memory in
which the calling function resides. You must declare the return address column for the
common block.

Inside a common block, you can declare the initial value of a CFA or a resource by using
the directives available for common blocks, see Call frame information directives for
common blocks, page 134. For more information about how to use these directives, see
Specifying rules for tracking resources and the stack depth, page 41 and Using CFI
expressions for tracking complex cases, page 43.

End a common block with the directive:

CFI ENDCOMMON name

where name is the name used to start the common block.
ANNOTATING YOUR SOURCE CODE WITHIN A DATA
BLOCK

The data block contains the actual tracking information for one continuous piece of
code.

Start a data block with the directive:
CFI BLOCK name USING commonblock

where name is the name of the new block and commonblockis the name of a previously
defined common block.

If the piece of code for the current data block is part of a defined function, specify the
name of the function with the directive:

CFI FUNCTION Iabel

where Iabel is the code label starting the function.
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If the piece of code for the current data block is not part of a function, specify this with
the directive:

CFI NOFUNCTION

End a data block with the directive:

CFI ENDBLOCK name

where name is the name used to start the data block.

Inside a data block, you can manipulate the values of the resources by using the
directives available for data blocks, see Call frame information directives for data
blocks, page 135. For more information on how to use these directives, see Specifying
rules for tracking resources and the stack depth, page 41, and Using CFI expressions for
tracking complex cases, page 43.

SPECIFYING RULES FOR TRACKING RESOURCES AND THE
STACK DEPTH

To describe the tracking information for individual resources, two sets of simple rules
with specialized syntax can be used:
o Rules for tracking resources

CFI resource { UNDEFINED | SAMEVALUE | CONCAT }

CFI resource { resource | FRAME(cfa, offset) }
o Rules for tracking the stack depth (CFAs)

CFI cfa { NOTUSED | USED }

CFI cfa { resource | resource + constant | resource - constant }
You can use these rules both in common blocks to describe the initial information for

resources and CFAs, and inside data blocks to describe changes to the information for
resources or CFAs.

In those rare cases where the descriptive power of the simple rules are not enough, you
can use a full CFI expression with dedicated operators to describe the information, see
Using CFI expressions for tracking complex cases, page 43. However, whenever
possible, you should always use a rule instead of a CFI expression.

Rules for tracking resources

The rules for resources conceptually describe where to find a resource when going back
one call frame. For this reason, the item following the resource name in a CFI directive
is referred to as the location of the resource.

To declare that a tracked resource is restored, in other words, already correctly located,
use SAMEVALUE as the location. Conceptually, this declares that the resource does not
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have to be restored because it already contains the correct value. For example, to declare
that a register R11 is restored to the same value, use the directive:

CFI R11 SAMEVALUE

To declare that a resource is not tracked, use UNDEFINED as location. Conceptually, this
declares that the resource does not have to be restored (when going back one call frame)
because it is not tracked. Usually it is only meaningful to use it to declare the initial
location of a resource. For example, to declare that R11 is a scratch register and does not
have to be restored, use the directive:

CFI R11 UNDEFINED

To declare that a resource is temporarily stored in another resource, use the resource
name as its location. For example, to declare that a register R11 is temporarily located
in a register R12 (and should be restored from that register), use the directive:

CFI R11 R12

To declare that a resource is currently located somewhere on the stack, use FRAME (cfa,
offset) as location for the resource, where cfa is the CFA identifier to use as “frame
pointer” and of fset is an offset relative the CFA. For example, to declare that a register
R11 is located at offset —4 counting from the frame pointer CFA_SP, use the directive:

CFI R11 FRAME (CFA_SP,-4)

For a composite resource there is one additional location, CONCAT, which declares that
the location of the resource can be found by concatenating the resource parts for the
composite resource. For example, consider a composite resource RET with resource
parts RETLO and RETHI. To declare that the value of RET can be found by investigating
and concatenating the resource parts, use the directive:

CFI RET CONCAT

This requires that at least one of the resource parts has a definition, using the rules
described above.

Rules for tracking the stack depth (CFAs)

In contrast to the rules for resources, the rules for CFAs describe the address of the
beginning of the call frame. The call frame often includes the return address pushed by
the assembler call instruction. The CFA rules describe how to compute the address of
the beginning of the current stack frame.

Each stack frame CFA is associated with a stack pointer. When going back one call
frame, the associated stack pointer is restored to the current CFA. For stack frame CFAs,
there are two possible rules—an offset from a resource (not necessarily the resource
associated with the stack frame CFA) or NOTUSED.
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To declare that a CFA is not used, and that the associated stack pointer should be tracked
as a normal resource, use NOTUSED as the address of the CFA. For example, to declare
that the CFA with the name CFA_SP is not used in this code block, use the directive:

CFI CFA_SP NOTUSED

To declare that a CFA has an address that is offset relative the value of a resource, specify
the stack pointer and the offset. For example, to declare that the CFA with the name
CFA_SP can be obtained by adding 4 to the value of the SP resource, use the directive:

CFI CFA_SP SP + 4

USING CFI EXPRESSIONS FOR TRACKING COMPLEX CASES

You can use call frame information expressions (CFI expressions) when the descriptive
power of the rules for resources and CFAs is not enough. However, you should always
use a simple rule if there is one.

CFI expressions consist of operands and operators. Three sets of operators are allowed
in a CFI expression:

e Unary operators
e Binary operators

e Ternary operators
In most cases, they have an equivalent operator in the regular assembler expressions.

In this example, R12 is restored to its original value. However, instead of saving it, the
effect of the two post increments is undone by the subtract instruction.

AddTwo:
cfi block addTwoBlock using myCommon
cfi function addTwo
cfi nocalls
cfi rl2 samevalue
add @rl2+, rl3
cfi rl2 sub(rl2, 2)
add @rl2+, rl3
cfi rl2 sub(rl2, 4)
sub #4, rl2
cfi rl2 samevalue
ret
cfi endblock addTwoBlock

For more information about the syntax for using the operators in CFI expressions, see
Call frame information directives for tracking resources and CFAs, page 136.
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STACK USAGE ANALYSIS DIRECTIVES

The stack usage analysis directives (CFI FUNCALL, CFI TAILCALL, CFI
INDIRECTCALL, and CFI NOCALLS) are used for building a call graph which is needed
for stack usage analysis. These directives can be used only in data blocks. When the data
block is a function block (in other words, when the CFI FUNCTION directive has been
used in the data block), you should not specify a caller parameter. When a stack usage
analysis directive is used in code that is shared between functions, you must use the
caller parameter to specify which of the possible functions the information applies to.

The CFI FUNCALL, CFI TAILCALL, and CFI INDIRECTCALL directives must be placed
immediately before the instruction that performs the call. The CFI NOCALLS directive
can be placed anywhere in the data block.

EXAMPLES OF USING CFI DIRECTIVES

The following is an example specific to the Arm core. More examples can be obtained
by generating assembler output when you compile a C source file.

Consider a Cortex-M3 device with its stack pointer R13, link register R14, and general
purpose registers RO-R12. Register RO, R2, R3, and R12 will be used as scratch
registers—these registers may be destroyed by a function call—whereas register R1
must be restored after the function call.

Consider the following short code sample with the corresponding call frame
information. At entry, assume that the register R14 contains a 32-bit return address. The
stack grows from high addresses toward zero. The CFA denotes the top of the call frame,
in other words, the value of the stack pointer after returning from the function.

Address CFA RI R4-RI1 1 RI14 RO, R2, R3, RI2 Assembler code
00000000 RI3+0 SAME SAME SAME  Undefined PUSH {rl,1r}
00000002 RI3+8 CFA-8 CFA- 4 MOVS «rl,#4
00000004 BL func2
00000008 POP {r0,1r}
0000000C RI3+0 RO SAME MOV rl,r0
0000000E SAME BX 1r

Table 12: Code sample with backtrace rows and columns

Each row describes the state of the tracked resources before the execution of the
instruction. As an example, for the MOV R1, RO instruction, the original value of the R1
register is located in the RO register, and the top of the function frame (the CFA column)
isR13 + 0. The row at address 0000 is the initial row, and the result of the calling
convention used for the function.
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The R14 column is the return address column—in other words, the location of the return
address. The R1 column has SAME in the initial row to indicate that the value of the R1
register will be restored to the same value it already has. Some of the registers are
undefined because they do not need to be restored on exit from the function.

Defining the names block

The names block for the small example above would be:

cfi names ArmCore

cfi stackframe cfa rl3 DATA

cfi resource r0:32, rl:32, r2:32, r3:32
cfi resource r4:32, r5:32, 1r6:32, 1r7:32
cfi resource r8:32, 1r9:32, rl0:32, rll:32
cfi resource rl1l2:32, rl3:32, rl4d:32

cfi endnames ArmCore

Defining the common block

cfi common trivialCommon using ArmCore
cfi codealign 2

cfi dataalign 4

cfi returnaddress rl4 CODE
cfi cfa rl3+0

cfi default samevalue

cfi r0 undefined

cfi r2 undefined

cfi r3 undefined

cfi rl2 undefined

cfi endcommon trivialCommon

Note: R13 cannot be changed using a CFI directive because it is the resource associated
with CFA.
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Defining the data block

You should place the CFI directives at the point where the backtrace information has
changed, in other words, immediately affer the instruction that changes the backtrace

information.
section MYCODE:CODE(2)
cfi block trivialBlock using trivialCommon
cfi function funcl
thumb

funcl push {rl,1r}
cfi rl frame(cfa, -8)
cfi rld frame(cfa, -4)
cfi cfa rl3+8
movs rl, #4
cfi funcall func2
bl func?2
pop {r0,1r}
cfi rl r0
cfi rld samevalue
cfi cfa rl3
mov rl,r0
cfi rl samevalue
bx 1r
cfi endblock trivialBlock
end

IAR Assembler User Guide
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e Using command line assembler options
e Summary of assembler options

e Description of assembler options

Using command line assembler options

Assembler options are parameters you can specify to change the default behavior of the
assembler. You can specify options from the command line—which is described in more
detail in this section—and from within the IAR Embedded Workbench® IDE.

The IDE Project Management and Building Guide for Arm describes how to set
assembler options in the IDE, and gives reference information about the available
options.

SPECIFYING OPTIONS AND THEIR PARAMETERS

To set assembler options from the command line, include them after the iasmarm
command:

iasmarm [options] [sourcefile] [options]
These items must be separated by one or more spaces, or tab characters.
Notice that a command line option has a short name or a long name:

e A short option name consists of one character, with or without parameters. You
specify it with a single dash, for example -r.

® A long name consists of one or several words joined by underscores, with or
without parameters. You specify it with double dashes, for example
--source_encoding.

If all the optional parameters are omitted, the assembler displays a list of available
options a screenful at a time. Press Enter to display the next screenful.

For example, when assembling the source file power?2 . s, use this command to generate
a list file to the default filename (power2.1st):

iasmarm power2.s -L
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Some options accept a filename (that may be prefixed by a path), included after the
option letter with a separating space. For example, to generate a list file with the name
list.1lst:

iasmarm power2.s -1 list.lst

Some options accept a parameter that is not a filename. For options with a long name,
the option and the parameter can be separated with a space character, an = sign, or a #.
For options with a short name, the parameter is included after the option letter, but
without a space. For example, to generate a list file to the default filename but in the
subdirectory named 1ist:

iasmarm power2.s -Llist)\

Note: The subdirectory you specify must already exist. The trailing backslash is
required to separate the name of the subdirectory from the default filename.
EXTENDED COMMAND LINE FILE

In addition to accepting options and source filenames from the command line, the
assembler can accept them from an extended command line file.

By default, extended command line files have the extension xc1, and can be specified
using the - £ command line option. For example, to read the command line options from
extend.xcl, enter:

iasmarm -f extend.xcl

Summary of assembler options
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This table summarizes the assembler options available from the command line:

Command line option Description

--aarch32 Generates code using the A32 instruction set
--aarché64 Generates code using the A64 instruction set
--abi Specifies a data model for generating code using the

Ab4 instruction set

--arm Sets the default mode for the assembler directive
CODE to Arm

-B Macro execution information

-c Conditional list

--cmse Enables CMSE secure object generation

--cpu Core configuration

Table 13: Assembler options summary
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Description

--cpu_mode

-D

-E

-e
--enable_hardware_workaround
--endian

-f

-L
-1
--legacy
-M
-N

--no_dwarf3_cfi

--no_it_verification

--no_path_in_file_macros

-0
-0
-

-r

Sets the mode for the assembler directive CODE
Defines preprocessor symbols

Maximum number of errors

Generates code in big-endian byte order
Enables a specific hardware workaround
Specifies the byte order for code and data
Extends the command line

Extends the command line, optionally with a
dependency

Floating-point coprocessor architecture
configuration

Opens standard input as source

Disables the automatic search for system include
files

Adds a search path for a header file
Lists #included text

Enables alternative register names, mnemonics, and
operators

Generates a list file to path

Generates a list file

Generates code linkable with older toolchains
Macro quote characters

Omits header from the assembler listing

Suppresses generation of DWARF 3 Call Frame
Information instructions

Suppresses the verification of the condition of
instructions following an IT instruction

Removes the path from the return value of the
symbols __FILE__ and __BASE_FILE__

Sets the object filename to path
Sets the object filename
Sets the number of lines per page in the list file

Generates debug information.

Table 13: Assembler options summary (Continued)
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Command line option Description

-S Sets silent operation

-s Case-sensitive user symbols

--source_encoding Specifies the encoding for source files

--suppress_vfe_header Suppresses the generation of VFE header
information

--system_include_dir Specifies the path for system include files

-t Tab spacing

--thumb Sets the default mode for the assembler directive

CODE to Thumb

-U Undefines a symbol

--use_unix_directory_ Uses / as directory separator in paths

separators

--version Sends assembler output to the console and then
exits.

-w Disables warnings

-x Includes cross-references

-Y Generates a list of file dependencies to a path

-y Generates a list of file dependencies

Table 13: Assembler options summary (Continued)

Description of assembler options
The following sections give detailed reference information about each assembler option.
If you use the page Extra Options to specify specific command line options, the IDE

does not perform an instant check for consistency problems like conflicting options,
duplication of options, or use of irrelevant options.

--aarch32
Syntax --aarch3?2
Description Use this option to generate code using the A32 instruction set in the AArch32 state for
the assembler directive CODE.
Note: This option has the same effect as the --cpu_mode=a32 option.
See also --cpu_mode, page 54.

IAR Assembler User Guide
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To set this option, use Project>Options>General Options>Target>Execution mode

--aarch64
Syntax --aarché64
Description Use this option to generate code using the A64 instruction set in the AArch64 state for
the assembler directive CODE.
Note: This option has the same effect as the --cpu_mode=a64 option.
See also --abi, page 51 and --cpu_mode, page 54.
To set this option, use Project>Options>General Options>Target>Execution mode
--abi
Syntax --abi={ilp32|1p64}
Parameters
ilp32 Generates A64 code for the ILP32 data model. Defines the
symbol __ilp32__
1p64 Generates A64 code for the LP64 data model. Defines the
symbol __1p64__.
Description Use this option to specify a data model for the generation of code using the A64
instruction set in the AArch64 environment.
See also --aarch64, page 51 and --cpu_mode, page 54.

To set related options, choose:

Project>Options>General Options>Target>Processor variant>Core
and

Project>Options>General Options>64-bit>Data model
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==arm
Syntax --arm
Description Use this option to make Arm (A32 in 32-bit mode) the default mode for the assembler
directive CODE.
See also --cpu_mode, page 54
[[E To set this option, use Project>Options>Assembler>Extra Options.
-B
Syntax -B
Description Use this option to make the assembler print macro execution information to the standard
output stream for every call to a macro. The information consists of:
o The name of the macro
o The definition of the macro
o The arguments to the macro
o The expanded text of the macro.
This option is mainly used in conjunction with the list file options -L or -1.
See also -L, page 60.
Project>Options>Assembler >List>Macro execution info
=C
Syntax -c{D|M|E|Aa|0O}
Parameters
D Disables list file
M Includes macro definitions
E Excludes macro expansions
A Includes assembled lines only

IAR Assembler User Guide
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-=cmse

Syntax

Description

--cpu
Syntax

Parameters

Description

See also
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0 Includes multiline code

Use this option to control the contents of the assembler list file.

This option is mainly used in conjunction with the list file options -L or -1.

-L, page 60.
To set related options, select:

Project>Options>Assembler>List

-—-cmse

Use this option to target secure mode in TrustZone for ARMv8-M. This option enables
access to system registers with the suffix _NS using the instructions MRS and MSR, and
enables the use of the instructions SG, TTA, TTAT, BLXNS, and BXNS. In 64-bit mode,
this option has no effect.

Note: To use this option, you must first select the option Project>Options>General
Options>32-bit>TrustZone.

To set this option, use Project>Options>Assembler>Extra Options.

--cpu target_core

target_core Can be values such as ARM7TDMT or architecture versions,
for example 4T or 8-a.AArch64. The default value in
32-bit mode is ARM7TDMTI and in 64-bit mode it is
Cortex-A53.

Use this option to specify the target core and get the correct instruction set.

The IAR C/C++ Development Guide for Arm for a complete list of coprocessor
architecture variants.
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--cpu_mode
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Syntax

Parameters

Description

See also

Syntax

Parameters

Description

Example

Project>Options>General Options>Target>Processor variant>Core

--cpu_mode {arm|a|thumb|t|a64}

a64 Uses the A64 instruction set in the AArch64 state
arm, a Uses the A32 instruction set in 32-bit mode
thumb, t Uses the T32 or T instruction set in 32-bit mode

Use this option to select the mode for the assembler directive CODE.

--aarch64, page 51

To set this option, use Project>Options>Assembler>Extra Options.

-Dsymbol[=value]

symbol The name of the symbol you want to define.

value The value of the symbol. If no value is specified, 1 is used.

Use this option to define a symbol to be used by the preprocessor.

You might want to arrange your source code to produce either the test version or the
production version of your application, depending on whether the symbol TESTVER was
defined. To do this, use include sections such as:

#ifdef TESTVER

. ; additional code lines for test version only
#endif
Then select the version required on the command line as follows:

Production version: iasmarm prog
Test version: iasmarm prog -DTESTVER
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Alternatively, your source might use a variable that you must change often. You can then
leave the variable undefined in the source, and use -D to specify the value on the
command line, for example:

iasmarm prog -DFRAMERATE=3

Project>Options>Assembler>Preprocessor>Defined symbols

-E
Syntax -Enumber
Parameters
number The number of errors before the assembler stops the
assembly. number must be a positive integer—o0 indicates no
limit.
Description Use this option to specify the maximum number of errors that the assembler reports. By
default, the maximum number is 100.
Project>Options>Assembler>Diagnostics>Max number of errors
-e
Syntax -e
Description Use this option to cause the assembler to generate code and data in big-endian byte

order. The default byte order is little-endian.
In 64-bit mode, this option has no effect.

Project>Options>General Options>32-bit>Byte order

--enable_hardware_workaround

Syntax --enable_hardware_workaround=waid[, waid. . .]
Parameters

waid The ID number of the workaround to enable. For a list of
available workarounds to enable, see the release notes.
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Use this option to make the assembler generate a workaround for a specific hardware
problem.

The release notes for the assembler for a list of available parameters.

To set this option, use Project>Options>Assembler>Extra Options.

--endian {little|l|big|b}
little, 1 (default) Specifies little-endian byte order.

big, b Specifies big-endian byte order.

Use this option to specify the byte order of the generated code and data.
In 64-bit mode, this option has no effect.

Project>Options>General Options>32-bit>Byte order

-f filename

The commands that you want to extend the command line
with are read from the specified file. Notice that there must
be a space between the option itself and the filename.

filename

For information about specifying a filename, see Using command line assembler
options, page 47.

Use this option to extend the command line with text read from the specified file.
The - £ option is particularly useful if there are many options which are more
conveniently placed in a file than on the command line itself.

To run the assembler with further options taken from the file extend.xc1, use:

iasmarm prog -f extend.xcl
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See also -f, page 56 and Extended command line file, page 48.

To set this option, use:

Project>Options>Assembler>Extra Options

Syntax --f filename

Parameters
filename The commands that you want to extend the command line
with are read from the specified file. Notice that there must
be a space between the option itself and the filename.

For information about specifying a filename, see Specifying options and their
parameters, page 47.

Description Use this option to make the assembler read command line options from the named file,
with the default filename extension xc1.

In the command file, you format the items exactly as if they were on the command line
itself, except that you may use multiple lines, because the newline character acts just as
a space or tab character.

Both C and C++ style comments are allowed in the file. Double quotes behave in the
same way as in the Microsoft Windows command line environment.

If you use the assembler option -v, extended command line files specified using -- £
will generate a dependency, but those specified using - £ will not generate a dependency.

See also -f, page 56.

[[E To set this option, use Project>Options>Assembler>Extra Options.

--fpu
Syntax --fpu fpu_variant
Parameters

fpu_variant A floating-point coprocessor architecture variant, such
as VFPv3 or none (default).
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Use this option to specify the floating-point coprocessor architecture variant, and get the
correct instruction set and registers.

Note: In 64-bit mode, and when a 64-bit device is used in 32-bit mode, this option has
no effect.
The IAR C/C++ Development Guide for Arm for a complete list of coprocessor

architecture variants.

Project>Options>General Options>32-bit>FPU

-G

Use this option to make the assembler read the source from the standard input stream,
rather than from a specified source file.

When -G is used, you cannot specify a source filename.

This option is not available in the IDE.

-g
By default, the assembler automatically locates the system include files. Use this option

to disable the automatic search for system include files. In this case, you might need to
set up the search path by using the - T assembler option.

Project>Options>Assembler>Preprocessor>Ignore standard include directories

-Ipath

path The search path for #include files.
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Use this option to specify paths to be used by the preprocessor. This option can be used
more than once on the command line.

By default, the assembler searches for #include files in the current working directory,
in the system header directories, and in the paths specified in the TASMARM_INC
environment variable. The - option allows you to give the assembler the names of
directories which it will also search if it fails to find the file in the current working
directory.

For example, using the options:

-Ic:\global\ -Ic:\thisproj\headers\

and then writing:

#include "asmlib.hdr"

in the source code, make the assembler search first in the current directory, then in the
directory c:\global\, and then in the directory C:\thisproj\headers\. Finally,
the assembler searches the directories specified in the TASMARM_INC environment
variable, provided that this variable is set, and in the system header directories.

Project>Options>Assembler>Preprocessor>Additional include directories

Use this option to list #include files in the list file.

By default, the assembler does not list #include file lines because these often come
from standard files, and would waste space in the list file. The -i option allows you to
list these file lines.

Project>Options>Assembler >List>#included text

-3

Use this option to enable alternative register names, mnemonics, and operators in order
to increase compatibility with other assemblers and, allow porting of code.
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See also Operator synonyms, page 158 and the chapter Migrating to the IAR Assembler for Arm.

m  Project>Options>Assembler>Language>Allow alternative register names,
mnemonics and operands

-L
Syntax -Llpath]
Parameters
No parameter Generates a listing with the same name as the source file, but
with the filename extension 1st.
path The path to the destination of the list file. Note that you must
not include a space before the path.
Description By default, the assembler does not generate a list file. Use this option to make the

assembler generate one and send it to the file [path] sourcename.lst.

-L cannot be used at the same time as -1.

Example To send the list file to 1ist\prog. 1st rather than the default prog.1st:
iasmarm prog -Llist\
. To set related options, select:

Project>Options>Assembler >List

Syntax -1 {filename|directory}

Parameters
filename The output is stored in the specified file. Note that you must
include a space before the filename. If no extension is
specified, 1st is used.

directory The output is stored in a file (filename extension 1st) which
is stored in the specified directory.

For information about specifying a filename or directory, see Using command line
assembler options, page 47.
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--legacy

-M

Syntax

Parameters

Description

Syntax

Parameters

Description

Example
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Use this option to make the assembler generate a listing and send it to the file you
specify. By default, the assembler does not generate a list file.

To generate a list file with the default filename, use the -L option instead.
To set related options, select:

Project>Options>Assembler >List

--legacy {RVCT3.0}

RVCT3.0 Specifies the linker in RVCT3.0. Use this parameter together
with the --aeabi option to generate code that should be
linked with the linker in RVCT3.0.

Use this option to generate object code that is compatible with the specified toolchain.
In 64-bit mode, this option has no effect.

To set this option, use Project>Options>Assembler>Extra Options.

-Mab

ab The characters to be used as left and right quotes of each
macro argument, respectively.

Use this option to sets the characters to be used as left and right quotes of each macro
argument to a and b respectively.

By default, the characters are < and >. The -M option allows you to change the quote
characters to suit an alternative convention, or simply allows a macro argument to
contain < or > themselves.

For example, using the option:

-M[]
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-N
Syntax

Description

See also

--no_it_verification

Syntax

Description
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in the source you would write, for example:
print [>]
to call a macro print with > as the argument.

Note: Depending on your host environment, it might be necessary to use quote marks
with the macro quote characters, for example:

iasmarm filename -M'<>’

Project>Options>Assembler >Language>Macro quote characters

-N
Use this option to omit the header section that is printed by default in the beginning of
the list file.

This option is useful in conjunction with the list file options -L or -1.

-L, page 60.

Project>Options>Assembler >List>Include header

--no_it_verification

Use this option to suppress the verification of the condition of instructions following an
IT instruction.

In 64-bit mode, this option has no effect.

To set this option, use Project>Options>Assembler>Extra Options.



--no_literal_pool

Syntax

Description

See also
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--no_literal_pool
Use this option for code that should run from a memory address range where read access
via the data bus is prohibited.

With the option --no_1literal_pool, the assembler uses the MOV32
pseudo-instruction instead of using a literal pool for LDR. Note that other instructions
can still cause read access via the data bus.

The option also affects the automatic library selection performed by the linker. An
IAR-specific ELF attribute is used for determining whether libraries compiled with the
option --no_literal_ pool should be used.

The option --no_literal_pool is only allowed for Armv6-M and Armv7 compatible
cores (includes Armv8-M, Armv8.1-M, Armv8-A and Armv8-R cores).

Note: In 64-bit mode, this option has no effect.

The compiler and linker options with the same name in the /AR C/C++ Development
Guide for Arm.

To set this option, use Project>Options>Assembler>Extra Options.

--no_path_in_file_macros

Syntax

Description

Syntax

Parameters

--no_path_in_file_macros

Use this option to exclude the path from the return value of the predefined preprocessor
symbols __FILE__ and __BASE_FILE__.

This option is not available in the IDE.

-O[path]

path The path to the destination of the object file. Note that you
cannot include a space before the path.
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-0
Syntax

Parameters

Description
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Parameters
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Use this option to set the path to be used on the name of the object file.

By default, the path is null, so the object filename corresponds to the source filename.
The -0 option lets you specify a path, for example, to direct the object file to a
subdirectory.

Note: -0 cannot be used at the same time as -o.

To send the object code to the file obj\prog. o rather than to the default file prog.o:
iasmarm prog -0obj\

Project>Options>General Options>Output>QOutput directories>Object files

-o {filename|directory}
filename The object code is stored in the specified file.

directory The object code is stored in a file (filename extension o)

which is stored in the specified directory.

For information about specifying a filename or directory, see Using command line
assembler options, page 47.

By default, the object code produced by the assembler is located in a file with the same
name as the source file, but with the extension o. Use this option to specify a different
output filename for the object code.

The -o option cannot be used at the same time as the -0 option.

Project>Options>General Options>Output>Output directories>Object files

-plines

lines The number of lines per page, which must be in the range 10

to 150.
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See also

Syntax

Description

Syntax

Description

Syntax

Parameters
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Use this option to set the number of lines per page explicitly.

This option is used in conjunction with the list options -L or -1.

-L, page 60
-1, page 60.

Project>Options>Assembler>List>Lines/page

Use this option to make the assembler generate debug information, which means the
generated output can be used in a symbolic debugger such as the IAR C-SPY®
Debugger.

Project>Options>Assembler >Output>Generate debug information

-S

By default, the assembler sends various minor messages via the standard output stream.
Use this option to make the assembler operate without sending any messages to the
standard output stream.

The assembler sends error and warning messages to the error output stream, so they are
displayed regardless of this setting.

This option is not available in the IDE.

-s{+|-}

+ Case-sensitive user symbols.

- Case-insensitive user symbols.
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--source_encoding

Syntax

Parameters

Description

See also

--suppress_vfe_header

Syntax

Description

See also
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Use this option to control whether the assembler is sensitive to the case of user symbols.
By default, case sensitivity is on.

By default, for example LABEL and label refer to different symbols. When -s- is used,
LABEL and label instead refer to the same symbol.

Project>Options>Assembler>Language>User symbols are case sensitive

--source_encoding {locale|utf8}

locale The default source encoding is the system locale encoding.

utfs The default source encoding is the UTF-8 encoding.

When reading a source file with no Byte Order Mark (BOM), use this option to specify
the encoding. If this option is not specified and the source file does not have a BOM, the
Raw encoding will be used.

For more information about encodings, see the /AR C/C++ Development Guide for
Arm.

To set this option, use Project>Options>Assembler>Extra Options.

--suppress_vfe_header

Use this option to suppress the automatic generation of VFE (Virtual Function
Elimination) header information in generated object code.

This option is useful in two cases:

o Making sure that the linker VFE optimization is not automatically turned on.

o Manually supplying VFE information in the assembler source code.

The linker option --vfe in the JAR C/C++ Development Guide for Arm.

To set this option, use Project>Options>Assembler>Extra Options.
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--system_include_dir

Syntax --system_include_dir path
Parameters
path The path to the system include files.
Description By default, the assembler automatically locates the system include files. Use this option

to explicitly specify a different path to the system include files. This might be useful if
you have not installed IAR Embedded Workbench in the default location.

This option is not available in the IDE.

-t
Syntax -tn
Parameters
n The tab spacing—must be in the range 2 to 9.
Description By default, the assembler sets 8 character positions per tab stop. Use this option to
specify a different tab spacing.
This option is useful in conjunction with the list options -L or -1.
See also -L, page 60
-1, page 60.
Project>Options>Assembler>List>Tab spacing
--thumb
Syntax --thumb
Description Use this option to make Thumb (T32 or T in 32-bit mode) the default mode for the

assembler directive CODE.

See also --cpu_mode, page 54
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See also

--version

Syntax

Description

=W
Syntax
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To set this option, use Project>Options>Assembler>Extra Options.

-Usymbol

symbol The predefined symbol to be undefined.

By default, the assembler provides certain predefined symbols.

Use this option to undefine such a predefined symbol to make its name available for your
own use through a subsequent -D option or source definition.

To use the name of the predefined symbol __TIME _ for your own purposes, you could
undefine it with:

iasmarm prog -U__TIME__

Predefined symbols, page 28.

This option is not available in the IDE.

--version

Use this option to make the assembler send version information to the console and then
exit.

This option is not available in the IDE.

-w[+|-|+n|-n|+m-n|-m-n] [s]

No parameter Disables all warnings.

+ Enables all warnings.
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See also

Syntax

Parameters

Description
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- Disables all warnings.

+n Enables just warning n.

-n Disables just warning n.

+m-n Enables warnings m to n.

-m-n Disables warnings m to n.

s Generates the exit code 1 if a warning message is produced.

By default, warnings generate exit code 0.

By default, the assembler displays a warning message when it detects an element of the
source code which is legal in a syntactical sense, but might contain a programming error.

Use this option to disable all warnings, a single warning, or a range of warnings.

Note: The -w option can only be used once on the command line.

To disable just warning 0 (unreferenced label), use this command:
iasmarm prog -w-0
To disable warnings O to 8, use this command:

iasmarm prog -w-0-8

Assembler diagnostics, page 153.
To set related options, select:

Project>Options>Assembler>Diagnostics

-x{D|I|2}

D Includes preprocessor #defines.
I Includes internal symbols.

2 Includes dual-line spacing.

Use this option to make the assembler include a cross-reference table at the end of the
list file.

69



Description of assembler options

See also

Syntax

Parameters

Description

Example

Syntax

Parameters

IAR Assembler User Guide
70 for Arm

This option is useful in conjunction with the list options -L or -1.

-L, page 60
-1, page 60.

Project>Options>Assembler>List>Include cross reference

-Y[path]

path The path to the location of the output file that contains the list
of dependency files. Note that you cannot include a space
before the path.

Use this option to list each source file opened by the assembler in a file.

By default, the path is null, so the filename corresponds to the source filename. The -y
option lets you specify a path, for example, to direct the file to a subdirectory.

Note: -y cannot be used at the same time as -y.
If -y or -v is used, the output file will have one make rule. The object file will be
dependent on all opened input files, including the full path. For example:

objectfile: sourcefile \
inputfile \

This option is not available in the IDE.

-y {filename|directory}

filename The list of dependency files is stored in the specified file.

directory The list of dependency files is stored in a file (filename
extension d) which is stored in the specified directory.
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For information about specifying a filename or directory, see Using command line
assembler options, page 47.

Description Use this option to list each source file opened by the assembler in a file. By default, the
list is located in a file with the same name as the source file, but with the extension d.
Use this option to specify a different output filename for the file.

The -y option cannot be used at the same time as the - option.
Example If -y or -v is used, the output file will have one make rule. The object file will be
dependent on all opened input files, including the full path. For example:

objectfile: sourcefile \
inputfile \

This option is not available in the IDE.
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Assembler operators

e Precedence of assembler operators
e Summary of assembler operators

e Description of assembler operators

Precedence of assembler operators

Each operator has a precedence number assigned to it that determines the order in which
the operator and its operands are evaluated. The precedence numbers range from 1 (the
highest precedence, that is, first evaluated) to 7 (the lowest precedence, that is, last
evaluated).

These rules determine how expressions are evaluated:

o The highest precedence operators are evaluated first, then the second highest
precedence operators, and so on until the lowest precedence operators are evaluated.

o Operators of equal precedence are evaluated from left to right in the expression.

o Parentheses (and ) can be used for grouping operators and operands, and for
controlling the order in which the expressions are evaluated. For example, this
expression evaluates to 1:

7/ (1+(2*3))

Summary of assembler operators

The following tables give a summary of the operators, in order of precedence.
Synonyms, where available, are shown after the operator name.

Note: The operator synonyms are enabled by the option -3. See also the chapter
Migrating to the IAR Assembler for Arm.

PARENTHESIS OPERATOR

Precedence: 1

() Parenthesis.
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UNARY OPERATORS
Precedence: 1
i

!, :LNOT:

~, :NOT:
LOW

HIGH

BYTE1L
BYTE2
BYTE3
BYTE4

LO12

LWRD

HWRD

DATE

SBREL

SFB
SFE

SIZEOF

Unary plus
Unary minus
Logical NOT
Bitwise NOT
Low byte

High byte

First byte

Second byte
Third byte

Fourth byte
Lower 12 bits of a symbol
Low word

High word
Current time/date

The offset to a symbol from the addressing origin of
its output segment.

Section begin
Section end

Section size

MULTIPLICATIVE ARITHMETIC OPERATORS

Precedence: 2

*

/

%, :MOD:

Multiplication
Division

Modulo



ADDITIVE ARITHMETIC OPERATORS

Precedence: 3

+

SHIFT OPERATORS

Precedence: 2.5-4
>>

: SHR:

<<

:SHL:

AND OPERATORS

Precedence: 3-8

&&

:LAND:

OR OPERATORS
Precedence: 3-8
||, :LOR:

:OR:
XOR

:LEOR:

:EOR:

Addition

Subtraction

Logical shift right (4)
Logical shift right (2.5)
Logical shift left (4)
Logical shift left (2.5)

Logical AND (5)
Logical AND (8)
Bitwise AND (5)
Bitwise AND (3)

Logical OR (6)
Bitwise OR (6)
Bitwise OR (3)
Logical exclusive OR (6)
Logical exclusive OR (8)
Bitwise exclusive OR (6)

Bitwise exclusive OR (3)

Assembler operators ___o
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COMPARISON OPERATORS

Precedence: 7

=, == Equal to

<>, 1= Not equal to

> Greater than

< Less than

UGT Unsigned greater than
ULT Unsigned less than

>= Greater than or equal to
<= Less than or equal to

Description of assembler operators

This section gives detailed descriptions of each assembler operator.

See also Expressions, operands, and operators, page 24.

() Parenthesis

Precedence 1

Description (and ) group expressions to be evaluated separately, overriding the default precedence
order.

Example 1+2%3 —> 7

(1+2)*3 —> 9

* Multiplication
Precedence 2

Description * produces the product of its two operands. The operands are taken as signed 32-bit
integers, and the result is also a signed 32-bit integer.

Example 2%2 -> 4
-2%2 -> -4
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+ Unary plus

Precedence
Description

Example

+ Addition

Precedence

Description

Example

— Unary minus

Precedence

Description

Example

- Subtraction

Precedence

Description

Assembler operators ___o

Unary plus operator; performs nothing.

+3 -> 3
3*+2 -> 6
3

The + addition operator produces the sum of the two operands which surround it. The
operands are taken as signed 32-bit integers, and the result is also a signed 32-bit integer.

92+19 -> 111
-2+2 -> 0
-2+-2 -> -4

The unary minus operator performs arithmetic negation on its operand.

The operand is interpreted as a 32-bit signed integer, and the result of the operator is the
two’s complement negation of that integer.

-3 —> -3
3*-2 -> -6
4--5 -> 9
3

The subtraction operator produces the difference when the right operand is taken away
from the left operand. The operands are taken as signed 32-bit integers, and the result is
also signed 32-bit integer.
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Example 92-19 -> 73
—2-2 —> -4
-2--2 —> 0

| Division
Precedence 2

Description / produces the integer quotient of the left operand divided by the right operator. The
operands are taken as signed 32-bit integers, and the result is also a signed 32-bit integer.

Example 9/2 -> 4
-12/3 -> -4
9/2%6 —-> 24

< Less than
Precedence 7
Description < evaluates to 1 (true) if the left operand has a numeric value that is less than the right
operand, otherwise it is 0 (false).
Example -1 <2 ->1
2<1->0
2 <2 -—>0

<= Less than or equal to

Precedence 7

Description <= evaluates to 1 (true) if the left operand has a numeric value that is less than or equal
to the right operand, otherwise it is O (false).

Example 1 <=2 ->1
2<=1->0
l1<=1->1
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<>, != Not equal to

Precedence 7

Description <>evaluates to O (false) if its two operands are identical in value or to 1 (true) if its two
operands are not identical in value.

Example 1 <>2 ->1
2 <>2 >0
'A' <> 'B' -> 1
=, == Equal to

Precedence 7

Description =evaluates to 1 (true) if its two operands are identical in value, or to O (false) if its two
operands are not identical in value.

Example 1=2->0
2 ==2 —>1
"ABC' = 'ABCD' -> 0
> Greater than
Precedence 7
Description > evaluates to 1 (true) if the left operand has a higher numeric value than the right

operand, otherwise it is O (false).

Example -1 >1->0
2>1 -—>1
1 >1->0

>= Greater than or equal to

Precedence 7

Description >= evaluates to 1 (true) if the left operand is equal to or has a greater numeric value than
the right operand, otherwise it is O (false).
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Example

&& Logical AND

Precedence

Description

Example

& Bitwise AND

Precedence

Description

Example

~ Bitwise NOT

Precedence

Description

Example
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1 >=2 ->0
2 >=1 —>1
1 >=1 -—>1

5

The precedence of : LAND: is 8.

&& or the synonym : LAND: performs logical AND between its two integer operands. If
both operands are non-zero the result is 1 (true), otherwise it is O (false).

1010B && 0011B -> 1
1010B && 0101B -> 1
1010B && 0000B -> O

5

The precedence of :AND: is 3.

& or the synonym : AND: performs bitwise AND between the integer operands. Each bit
in the 32-bit result is the logical AND of the corresponding bits in the operands.

1010B & 0011B -> 0010B

1010B & 0101B -> 0000B
1010B & 0000B -> 0000B

~ or the synonym :NOT: performs bitwise NOT on its operand. Each bit in the 32-bit
result is the complement of the corresponding bit in the operand.

~ 1010B -> 11111111111111111111111111110101B
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| Bitwise OR
Precedence 6

The precedence of :0R: is 3.

Description | or the synonym : OR: performs bitwise OR on its operands. Each bit in the 32-bit result
is the inclusive OR of the corresponding bits in the operands.

Example 1010B | 0101B -> 1111B

1010B | 0000B -> 1010B

A Bitwise exclusive OR
Precedence 6

The precedence of : EOR: is 3.

Description ~ or the synonym :EOR: performs bitwise XOR on its operands. Each bit in the 32-bit
result is the exclusive OR of the corresponding bits in the operands.

Example 10108 ~ 0101B -> 1111B
1010B ~ 0011B -> 1001B

% Modulo

Precedence 2

Description sor the synonym :MOD: produces the remainder from the integer division of the left
operand by the right operand. The operands are taken as signed 32-bit integers, and the
result is also a signed 32-bit integer.
X % Yisequivalent to X-v* (X/Y) using integer division.

Example 2%2->0
12 7 -=> 5
3% 2 -—>1
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! Logical NOT

Precedence
Description

Example

|| Logical OR

Precedence
Description

Example

<< Logical shift left

Precedence

Description

Example

>> Logical shift right

Precedence

Description
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! or the synonym :LNOT: negates a logical argument.

! 0101B -> 0
! 0000B -> 1

6

| | or the synonym :LOR: performs a logical OR between two integer operands.
1010B || 0000B —> 1

0000B || 0000B -> 0

4

<< or the synonym : SHL: shifts the left operand, which is always treated as unsigned,
to the left. The number of bits to shift is specified by the right operand, interpreted as an
integer value between 0 and 32.

Note: The precedence of : SHL: is 2.5.

00011100B << 3 —-> 11100000B
00000111111111111B << 5 —> 11111111111100000B
14 << 1 -> 28

4

>> or the synonym : SHR: shifts the left operand, which is always treated as unsigned,
to the right. The number of bits to shift is specified by the right operand, interpreted as
an integer value between 0 and 32.

Note: The precedence of : SHR: is 2.5.



Example

BYTEI First byte

Precedence

Description

Example

BYTE2 Second byte

Precedence

Description

Example

BYTE3 Third byte

Precedence

Description

Example

BYTE4 Fourth byte

Precedence

Description

Example
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01110000B >> 3 -> 00001110B
11111111112111111B >> 20 -=> 0
14 >> 1 —> 7

BYTEL takes a single operand, which is interpreted as an unsigned 32-bit integer value.
The result is the unsigned, 8-bit integer value of the lower order byte of the operand.

BYTE1 OxABCD -> 0xCD

BYTE?2 takes a single operand, which is interpreted as an unsigned 32-bit integer value.
The result is the middle-low byte (bits 15 to 8) of the operand.

BYTE2 0x12345678 -> 0x56

BYTE3 takes a single operand, which is interpreted as an unsigned 32-bit integer value.
The result is the middle-high byte (bits 23 to 16) of the operand.

BYTE3 0x12345678 -> 0x34

BYTE4 takes a single operand, which is interpreted as an unsigned 32-bit integer value.
The result is the high byte (bits 31 to 24) of the operand.

BYTE4 0x12345678 -> 0x12
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DATE Current time/date

Precedence

Description

Example

HIGH High byte

Precedence

Description

Example

HWRD High word

Precedence

Description

Example
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1

DATE gets the time when the current assembly began.

The DATE operator takes an absolute argument (expression) and returns:

DATE 1 Current second (0-59).

DATE 2 Current minute (0-59).

DATE 3 Current hour (0-23).

DATE 4 Current day (1-31).

DATE 5 Current month (1-12).

DATE 6 Current year MOD 100 (1998 —>98, 2000 —00, 2002 —>02).

To specity the date of assembly:

today: DC8 DATE 5, DATE 4, DATE 3

HIGH takes a single operand to its right which is interpreted as an unsigned, 16-bit
integer value. The result is the unsigned 8-bit integer value of the higher order byte of
the operand.

HIGH OxABCD -> 0xAB

HWRD takes a single operand, which is interpreted as an unsigned, 32-bit integer value.
The result is the high word (bits 31 to 16) of the operand.

HWRD 0x12345678 -> 0x1234



LOW Low byte

Precedence

Description

Example
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Low takes a single operand, which is interpreted as an unsigned, 32-bit integer value.
The result is the unsigned, 8-bit integer value of the lower order byte of the operand.

LOW OxABCD -> 0xCD

LOI2 Lower 12 bits of symbol

Precedence
Description

Example

LWRD Low word

Precedence

Description

Example

SBREL

Syntax
Precedence

Description

1
Low uses the lower 12 bits of a symbol. This operator is only available in 64-bit mode.

LO12(0x1234) -> 0x234

LWRD takes a single operand, which is interpreted as an unsigned, 32-bit integer value.
The result is the low word (bits 15 to 0) of the operand.

LWRD 0x12345678 -> 0x5678

SBREL expr

The expression must evaluate to a symbol s, with a possible addend a, written as s+a.

The result is the offset to s from the addressing origin of its output segment, plus the
addend.

The result is s+a-base, if the origin of the output segment for s is base.

The normal usage is for the symbol s to be in . data, and to have base address of .data
in R9.
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SFB section begin

Syntax
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SFE section end
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SBREL (array+4) ->4 if array is placed first in its output segment.

SFB(section [{+|-}offset])

The name of a , which must be defined before SFB is used.

offset An optional offset from the start address. The parentheses are
optional if offset is omitted.

SFB accepts a single operand to its right. The operator evaluates to the absolute address
of the first byte of that section. This evaluation occurs at linking time.

name sectionBegin
section MYCODE:CODE(2) ; Forward declaration
; of MYCODE.
section MYCONST:CONST (2)
data
start dc32 sfb (MYCODE)
end

Even if this code is linked with many other modules, start is still set to the address of
the first byte of the section MYCODE.

SFE (section [{+ | -} offset])

The name of a , which must be defined before SFE is used.

offset An optional offset from the start address. The parentheses are
optional if of £set is omitted.

SFE accepts a single operand to its right. The operator evaluates to the address of the first
byte after the section end. This evaluation occurs at linking time.
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Example name sectionEnd
section MYCODE:CODE(2) ; Forward declaration
; of MYCODE.
section MYCONST:CONST (2)
data
end dc32 sfe (MYCODE)
end

Even if this code is linked with many other modules, end is still set to the first byte after
the section MYCODE.

The size of the section MYCODE can be achieved by using the SIZEOF operator.

SIZEOF section size

Syntax SIZEOF section

Precedence 1

Parameters
The name of a relocatable , which must be defined before
SIZEOF is used.

Description SIZEOF generates SFE-SFB for its argument. That is, it calculates the size in bytes of a

section. This is done when modules are linked together.

Example These two files set size to the size of the section MYCODE.
Table.s:

module table
section MYCODE:CODE ; Forward declaration of MYCODE.
section SEGTAB:CONST(2)
data
size dc32 sizeof (MYCODE)
end

Application.s:

module application

section MYCODE:CODE(2)

code

nop ; Placeholder for application.
end
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UGT Unsigned greater than

Precedence 7

Description UGT evaluates to 1 (true) if the left operand has a larger value than the right operand,
otherwise it is 0 (false). The operation treats the operands as unsigned values.

Example 2 UGT 1 -> 1

-1 UGT 1 —> 1

ULT Unsigned less than

Precedence 7

Description ULT evaluates to 1 (true) if the left operand has a smaller value than the right operand,
otherwise it is O (false). The operation treats the operands as unsigned values.

Example 1 ULT 2 -> 1
-1 ULT 2 -> 0

XOR Logical exclusive OR

Precedence 6

Description XOR or the synonym : LEOR: evaluates to 1 (true) if either the left operand or the right
operand is non-zero, but to O (false) if both operands are zero or both are non-zero. Use
XOR to perform logical XOR on its two operands.

Note: The precedence of : LEOR: is 8.

Example 0101B XOR 1010B -> 0
0101B XOR 0000B -> 1

IAR Assembler User Guide
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This chapter gives a summary of the assembler directives and provides detailed

reference information for each category of directives.

Summary of assembler directives

The assembler directives are classified into these groups according to their function:

Module control directives, page 94

Symbol control directives, page 97

Mode control directives, page 99

Section control directives, page 101

Value assignment directives, page 105

Conditional assembly directives, page 106

Macro processing directives, page 108

Listing control directives, page 116

C-style preprocessor directives, page 121

Data definition or allocation directives, page 126

Assembler control directives, page 129

Function directives, page 132

Call frame information directives for names blocks, page 133.
Call frame information directives for common blocks, page 134
Call frame information directives for data blocks, page 135
Call frame information directives for tracking resources and CFAs, page 136

Call frame information directives for stack usage analysis, page 139

This table gives a summary of all the assembler directives:

Directive Description Section

_args Is set to number of arguments passed to macro. Macro processing

S Includes a file. Assembler control

#define Assigns a value to a label. C-style preprocessor

#elif Introduces a new condition in an #if...#endif C-style preprocessor
block.

Table 14: Assembler directives summary
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Directive Description Section

#else Assembles instructions if a condition is false. C-style preprocessor
#endif Ends an #if, #ifdef, or #ifndef block. C-style preprocessor
#error Generates an error. C-style preprocessor
#if Assembles instructions if a condition is true. C-style preprocessor
#ifdef Assembles instructions if a symbol is defined. C-style preprocessor
#ifndef Assembles instructions if a symbol is undefined. C-style preprocessor
#include Includes a file. C-style preprocessor
#message Generates a message on standard output. C-style preprocessor
#pragma Recognized but ignored. C-style preprocessor
#undef Undefines a label. C-style preprocessor

/*comment* /

//

AAPCS
ALTIAS

ALIGN

ALIGNRAM
ALIGNROM

ARM

ASEGN
ASSIGN

CALL_GRAPH_R
ooT

CASEOFF
CASEON
CFI

CODE

C-style comment delimiter.

C++ style comment delimiter.

Assigns a permanent value local to a module.
Sets module attributes.

Assigns a permanent value local to a module.

Aligns the program location counter by inserting
zero-filled bytes.

Aligns the program location counter.

Aligns the program location counter by inserting
zero-filled bytes.

Interprets subsequent instructions as 32-bit (Arm)
instructions.

Begins a named absolute segment.
Assigns a temporary value.

Specifies that a function is a call graph root.

Disables case sensitivity.
Enables case sensitivity.

Specifies call frame information.

Interprets subsequent instructions as Arm, Thumb,
or A64 instructions, depending on the setting of
related assembler options.

Assembler control
Assembler control
Value assignment
Module control
Value assignment

Section control

Section control

Section control

Mode control

Segment control
Value assignment

Function

Assembler control
Assembler control

Call frame
information

Mode control

Table 14: Assembler directives summary (Continued)
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Directive Description Section
CODE16 Interprets subsequent instructions as |6-bit Mode control
(Thumb) instructions. Replaced by THUMB.
CODE32 Interprets subsequent instructions as 32-bit (Arm) Mode control
instructions. Replaced by ARM.
COL Sets the number of columns per page. Retained for  Listing control
backward compatibility reasons—recognized but
ignored.
DATA Defines an area of data within a code section. Mode control
DATA64 Defines an area with 64-bit alignment data within a Mode control
code section.
DC8 Generates 8-bit constants, including strings. Data definition or
allocation
DC16 Generates |6-bit constants. Data definition or
allocation
DC24 Generates 24-bit constants. Data definition or
allocation
DC32 Generates 32-bit constants. Data definition or
allocation
DC64 Generates 64-bit constants. Data definition or
allocation
DCB Generates 8-bit byte constants, including strings. Data definition or
allocation
DCD Generates 32-bit long word constants. Alias for Data definition or
DC32. allocation
DCQ Generates 64-bit long constants. Alias for DC64. Data definition or
allocation
DCW Generates |6-bit word constants, including strings. Data definition or
Alias for DC16. allocation
DEFINE Defines a file-wide value. Value assignment
DF16 Generates |6-bit half precision floating point Data definition or
constants. allocation
DF32 Generates 32-bit floating-point constants. Data definition or
allocation
DF64 Generates 64-bit floating-point constants. Data definition or

allocation

Table 14: Assembler directives summary (Continued)
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Directive

Description

Section

DS8

DS16

Ds24

DS32

Ds64

ELSE

ELSEIF

END
ENDIF

ENDM
ENDR
EQU
EVEN
EXITM
EXTERN

EXTWEAK

IF

IMPORT
INCLUDE

LIBRARY

LOCAL
LSTCND
LSTCOD

Allocates space for 8-bit integers.

Allocates space for |6-bit integers.

Allocates space for 24-bit integers.

Allocates space for 32-bit integers.

Allocates space for 64-bit integers.

Assembles instructions if a condition is false.

Specifies a new condition in an IF...ENDIF block.

Ends the assembly of the last module in a file.

Ends an IF block.

Ends a macro definition.
Ends a repeat structure.

Assigns a permanent value local to a module.

Aligns the program counter to an even address.

Exits prematurely from a macro.
Imports an external symbol.

Imports an external symbol (which can be
undefined.

Assembles instructions if a condition is true.

Imports an external symbol.
Includes a file.

Begins a module—an alias for PROGRAM and
NAME.

Creates symbols local to a macro.
Controls conditional assembler listing.

Controls multi-line code listing.

Data definition or
allocation

Data definition or
allocation

Data definition or
allocation

Data definition or
allocation

Data definition or
allocation

Conditional
assembly

Conditional
assembly

Module control

Conditional
assembly

Macro processing
Macro processing
Value assignment
Section control
Macro processing
Symbol control

Symbol control

Conditional
assembly

Symbol control
Assembler control

Module control

Macro processing
Listing control

Listing control

Table 14: Assembler directives summary (Continued)
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Directive Description Section

LSTEXP Controls the listing of macro generated lines. Listing control

LSTMAC Controls the listing of macro definitions. Listing control

LSTOUT Controls assembler-listing output. Listing control

LSTPAG Retained for backward compatibility reasons. Listing control
Recognized but ignored.

LSTREP Controls the listing of lines generated by repeat Listing control
directives.

LSTXRF Generates a cross-reference table. Listing control

LTORG Directs the current literal pool to be assembled Assembler control
immediately following the directive.

MACRO Defines a macro. Macro processing

MODULE Begins a module—an alias for PROGRAM and Module control
NAME.

NAME Begins a program module. Module control

ODD Aligns the program location counter to an odd Section control
address.

OVERLAY Recognized but ignored. Symbol control

PAGE Retained for backward compatibility reasons. Listing control

PAGSIZ Retained for backward compatibility reasons. Listing control

PRESERVES Sets a module attribute. Module control

PROGRAM Begins a module. Module control

PUBLIC Exports symbols to other modules. Symbol control

PUBWEAK Exports symbols to other modules, multiple Symbol control
definitions allowed.

RADIX Sets the default base. Assembler control

REPT Assembles instructions a specified number of Macro processing
times.

REPTC Repeats and substitutes characters. Macro processing

REPTI Repeats and substitutes strings. Macro processing

REQUIRE Forces a symbol to be referenced. Symbol control

REQUIRES Sets a module attribute. Module control

RSEG Begins a section. Section control

RTMODEL Declares runtime model attributes. Module control

Table 14: Assembler directives summary (Continued)
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Directive Description Section
SECTION Begins a section. Section control
SECTION_TYPE Sets ELF type and flags for a section. Section control
SETA Assigns a temporary value. Value assignment
THUMB Interprets subsequent instructions as Thumb Mode control

execution-mode instructions.

Table 14: Assembler directives summary (Continued)

Description of assembler directives

The following pages give reference information about the assembler directives.

Module control directives

Syntax AAPCS [modifier [...]]
END
NAME symbol
PRESERVES
PROGRAM symbol
REQUIRES8

RTMODEL key, value

Parameters
key A text string specifying the key.

modifier An AAPCS extension—possible values are INTERWORK, VFP,
VFP_COMPATIBLE, ROPI, RWPI, RWPI_COMPATIBLE. Modifiers can
be combined to specify AAPCS variants.

symbol Name assigned to module.

value A text string specifying the value.

IAR Assembler User Guide
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Description Module control directives are used for marking the beginning and end of source program
modules, and for assigning names to them. For information about the restrictions that
apply when using a directive in an expression, see Expression restrictions, page 34.

Directive Description Expression restrictions

END Ends the assembly of the last module in a file. Locally defined symbols
plus offset or integer
constants

NAME Begins a module—alias to PROGRAM. No external references
Absolute

PROGRAM Begins a module. No external references
Absolute

RTMODEL Declares runtime model attributes. Not applicable

Table 15: Module control directives

Beginning a program module

Use NAME or PROGRAM to begin a program module, and to assign a name for future
reference by the IAR XLINK Linker, the [AR XAR Library Builder, and the IAR XLIB
Librarian.

Program modules are unconditionally linked by XLINK, even if other modules do not
reference them.

Beginning a module

Use any of the directives NAME or PROGRAM to begin an ELF module, and to assign a
name.

A module is included in the linked application, even if other modules do not reference
them. For more information about how modules are included in the linked application,
read about the linking process in the /AR C/C++ Development Guide for Arm.

Note: There can be only one module in a file.

Terminating the source file

Use END to indicate the end of the source file. Any lines after the END directive are
ignored. The END directive also ends the module in the file.

Setting module attributes for AEABI compliance

In 32-bit mode, you can set specific attributes on a module to inform the linker that the
exported functions in the module are compliant to certain parts of the AEABI standard.
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Use AAPCS, optionally with modifiers, to indicate that a module is compliant with the
AAPCS specification. Use PRESERVES if the module preserves an 8-byte aligned stack
and REQUIRES if an 8-byte aligned stack is expected.

Note: It is up to you to verify that the module is compliant to these parts, as the
assembler does not verify this. In 64-bit mode, these directives have no effect.

Declaring runtime model attributes

IAR Assembler User Guide
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Use RTMODEL to enforce consistency between modules. All modules that are linked
together and define the same runtime attribute key must have the same value for the
corresponding key value, or the special value *. Using the special value * is equivalent
to not defining the attribute at all. It can however be useful to explicitly state that the
module can handle any runtime model.

A module can have several runtime model definitions.

Note: The compiler runtime model attributes start with double underscores. In order to
avoid confusion, this style must not be used in the user-defined assembler attributes.

If you are writing assembler routines for use with C or C++ code, and you want to
control the module consistency, refer to the JAR C/C++ Development Guide for Arm.

The following examples defines three modules in one source file each, where:

e MOD_1 and MOD_2 cannot be linked together since they have different values for
runtime model CAN.

e MOD_1 and MOD_3 can be linked together since they have the same definition of
runtime model RTOS and no conflict in the definition of CAN.

e MOD_2 and MOD_3 can be linked together since they have no runtime model
conflicts. The value * matches any runtime model value.

Assembler source file f1.s:

module mod_1

rtmodel "CAN", "IS011519"
rtmodel "Platform", "M7"
end

Assembler source file £2.s:

module mod_2

rtmodel "CAN", "15011898"
rtmodel "Platform", "*"
end



Assembler source file £3.s:

module mod_3

Symbol control directives

Syntax

Parameters

Description

Assembler directives ___¢

rtmodel "Platform", "M7"
end
EXTERN symbol [,symboll
EXTWEAK symbol [, symbol]
IMPORT symbol [,symbol]
PUBLIC symbol [,symbol]
PUBWEAK symbol [,symbol]
REQUIRE symbol
label Label to be used as an alias for a C/C++ symbol.
symbol Symbol to be imported or exported.

These directives control how symbols are shared between modules:

Directive Description

EXTERN, IMPORT

Imports an external symbol.

EXTWEAK Imports an external symbol. The symbol can be undefined.

OVERLAY Recognized but ignored.

PUBLIC Exports symbols to other modules.

PUBWEAK Exports symbols to other modules, multiple definitions
allowed.

REQUIRE Forces a symbol to be referenced.

Table 16: Symbol control directives

Exporting symbols to other modules

Use PUBLIC to make one or more symbols available to other modules. Symbols defined
PUBLIC can be relocatable or absolute, and can also be used in expressions (with the

same rules as for other symbols).
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The pUBLIC directive always exports full 32-bit values, which makes it feasible to use
global 32-bit constants also in assemblers for 8-bit and 16-bit processors. With the Low,
HIGH, >>, and << operators, any part of such a constant can be loaded in an 8-bit or
16-bit register or word.

There can be any number of PUBLIC-defined symbols in a module.

Exporting symbols with multiple definitions to other modules

PUBWEAK is similar to PUBLIC except that it allows the same symbol to be defined in
more than one module. Only one of those definitions is used by ILINK. If a module
containing a PUBLIC definition of a symbol is linked with one or more modules
containing PUBWEAK definitions of the same symbol, ILINK uses the PUBLIC definition.

Note: Library modules are only linked if a reference to a symbol in that module is made,
and that symbol was not already linked. During the module selection phase, no
distinction is made between PUBLIC and PUBWEAK definitions. This means that to
ensure that the module containing the PUBLIC definition is selected, you should link it
before the other modules, or make sure that a reference is made to some other PUBLIC
symbol in that module.

Importing symbols

Example
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Use EXTERN or IMPORT to import an untyped external symbol.
The REQUIRE directive marks a symbol as referenced. This is useful if the section

containing the symbol must be loaded even if the code is not referenced.

The following example defines a subroutine to print an error message, and exports the
entry address err so that it can be called from other modules. Because the message is
enclosed in double quotes, the string will be followed by a zero byte.

It defines print as an external routine—the address is resolved at link time.

name errorMessage
extern print
public err

section MYCODE:CODE(2)

arm
err adr r0,msg
bl print
bx 1r
data
msg dc8 "*% Error **"
end



Mode control directives

Syntax

Description

ARM

CODE

CODE16

CODE32

DATA

DATA64

THUMB

Assembler directives ___¢

These directives provide control over the processor mode:

Directive

Description

ARM, CODE32

CODE

CODEl6

DATA

DATA64

THUMB

Subsequent instructions are assembled as 32-bit (Arm) instructions.
Labels within a CODE32 area have bit 0 set to 0. Force 4-byte
alignment.

Subsequent instructions are interpreted as Arm or Thumb instructions,
depending on the setting of the assembler option --arm,
--cpu_mode, or --thumb, or as Aé4 instructions in AArché4 state,
if any of the options --aarché64, --abi, or --cpu_mode a64
have been used.

Subsequent instructions are assembled as |6-bit (Thumb) instructions,
using the traditional CODE16 syntax. Labels within a CODEI6 area
have bit O set to |. Force 2-byte alignment.

Defines an area of data within a code section, where labels work as in a
CODE32 area.

Defines an area of 64-bit aligned data within a code section, where
labels work as in a CODE area for the Aé4 instruction set in the
AArché4 state.

Subsequent instructions are assembled either as 16-bit Thumb
instructions, or as 32-bit Thumb-2 instructions if the specified core
supports the Thumb-2 instruction set. The assembler syntax follows
the Unified Assembler syntax as specified by Arm Limited.

Table 17: Mode control directives

To change between the Thumb and Arm processor modes, use the CODE16/THUMB and
CODE32/ARM directives with the BX instruction (Branch and Exchange) or some other
instruction that changes the execution mode. The CODE16/THUMB and CODE32/ARM
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Example
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mode directives do not assemble to instructions that change the mode, they only instruct
the assembler how to interpret the following instructions.

The use of the mode directives CODE32 and CODEL16 is deprecated. Instead, use ARM and
THUMB, respectively.

Always use the DATA directive when defining data in a Thumb code section with DC8,
DC16, or DC32, otherwise labels on the data will have bit O set. Note that there is no way
of changing between the Arm or Thumb processor modes to the A64 instruction set in
the AArch64 state, or back.

Note: Be careful when porting assembler source code written for other assemblers. The
IAR Assembler always sets bit 0 on Thumb code labels (local, external or public). See
the chapter Migrating to the IAR Assembler for Arm for details.

The assembler will initially be in Arm mode, except if you specified a core which does
not support Arm mode. In this case, the assembler will initially be in Thumb mode.

The following example shows how a Thumb entry to an Arm function can be
implemented:

name modeChange
section MYCODE:CODE (2)
thumb
thumbEntry
bx pC ; Branch to armEntry, and
; change execution mode.
nop ; For alignment only.
arm
armEntry

end
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The following example shows how 32-bit labels are initialized after the DATA directive.

The labels can be used within a Thumb section.

name dataDirective
section MYCODE:CODE (2)
thumb
thumbLabel 1dr r0,datalabel
bx 1r
data ; Change to data mode, so
; that bit 0 is not set
; on labels.
dataLabel dc32 0x12345678
dc32 0x12345678
end

Section control directives

Syntax

Parameters

ALIGN align [,valuel

ALIGNRAM align

ALIGNROM align [,value]

ASEGN section [:type]l [:flag] [,address]
EVEN [valuel

ODD [value]

RSEG section [:type]l [:flag]l [(align)]
SECTION section :type [:flag] [(align)]

SECTION_TYPE type-expr {,flags-expr}

address Address where this section part is placed.

align The power of two to which the address should be aligned. The
permitted range is O to 8. The default align value is 0, except for code
sections where the default is 1.
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Description
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flag

section

type

value

type-expr

flags-expr

ROOT, NOROOT

ROOT (the default mode) indicates that the section fragment must not
be discarded.

NOROOT means that the section fragment is discarded by the linker if
no symbols in this section fragment are referred to. Normally, all
section fragments except startup code and interrupt vectors should
set this flag.

REORDER, NOREORDER

NOREORDER (the default mode) starts a new fragment in the section
with the given name, or a new section if no such section exists.

REORDER starts a new section with the given name.

The name of the section. The section name is a user-defined symbol
that follows the rules described in Symbols, page 26.

The memory type, which can be either CODE, CONST, or DATA.

4-byte value used for padding, default is zero. The padding demand
determines how many bytes are used from the value, starting from
the lowest byte.

A constant expression identifying the ELF type of the section.

A constant expression identifying the ELF flags of the section.

The section directives control how code and data are located. For information about the
restrictions that apply when using a directive in an expression, see Expression
restrictions, page 34.

Directive Description Expression restrictions

ALIGN Aligns the program location counter by inserting No external references
zero-filled bytes. Absolute

ALIGNRAM Aligns the program location counter by No external references
incrementing it. Absolute

ALIGNROM Aligns the program location counter by inserting No external references
zero-filled bytes. Absolute

ASEGN Begins a named absolute section. No external references
Absolute

EVEN Aligns the program counter to an even address.  No external references

Absolute

Table 18: Section control directives
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Directive Description Expression restrictions

ODD Aligns the program counter to an odd address. ~ No external references
Absolute

RSEG Begins an ELF section—alias to SECTION. No external references
Absolute

SECTION Begins an ELF section. No external references

SECTION_TYPE Sets ELF type and flags for a section.

STACK Begins a stack segment.

Absolute

Table 18: Section control directives (Continued)

Beginning a named absolute segment

Use ASEGN to start a named absolute segment located at the address address.

This directive has the advantage of allowing you to specify the memory type of the

segment.

Beginning a relocatable section

Use SECTION (or RSEG) to start a new section. The assembler maintains separate
location counters (initially set to zero) for all sections, which makes it possible to switch
sections and mode anytime without having to save the current program location counter.

Note: The first instance of a SECTION or RSEG directive must not be preceded by any
code generating directives, such as DC8 or DS8, or by any assembler instructions.

To set the ELF type, and possibly the ELF flags for the newly created section, use
SECTION_TYPE. By default, the values of the flags are zero. For information about valid

values, refer to the ELF documentation.

In the following example, the data following the first SECTION directive is placed in a

relocatable section called MYDATA.

The code following the second SECTION directive is placed in a relocatable section

called MYCODE:

calculate
subrtn,divrtn

name
extern

section MYDATA:DATA (2)

data
funcTable dc32 subrtn
dc32 divrtn
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section MYCODE:CODE (2)

arm

main 1ldr r0,=funcTable ; Get address, and
1dr pc, [r0] ; jump to it.
end

Aligning a section
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Use ALIGNROM to align the program location counter to a specified address boundary.
You do this by specifying an expression for the power of two to which the program
counter should be aligned. That is, a value of 1 aligns to an even address, and a value of
2 aligns to an address evenly divisible by 4.

The alignment is made relative to the section start—normally this means that the section
alignment must be at least as large as that of the alignment directive to give the desired
result.

ALIGNROM aligns by inserting zero/filled bytes, up to a maximum of 255. The EVEN
directive aligns the program counter to an even address (which is equivalent to
ALIGNROM 1), and the oDD directive aligns the program location counter to an odd
address. The value used for padding bytes must be within the range 0 to 255.

Use ALIGNRAM to align the program location counter to a specified address boundary.
The expression gives the power of two to which the program location counter should be
aligned. ALTGNRAM aligns by incrementing the program location counter—no data is
generated.

For both RAM and ROM, the parameter align can be within the range O to 30.

This example starts a section, and adds some data. It then aligns to a 64-byte boundary
before creating a 64-byte table. The section has an alignment of 64 bytes to ensure the
64-byte alignment of the table.

name alignment
section MYDATA:DATA(6) ; Start a relocatable data
; section aligned to a
; 64-byte boundary.
data
targetl dslé6 1 ; Two bytes of data.
alignram 6 ; Align to a 64-byte boundary
results ds8 64 ; Create a 64-byte table, and
target?2 dslé6 1 ; two more bytes of data.
alignram 3 ; Align to an 8-byte boundary
ages ds8 64 ; and create another 64-byte
; table.
end
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Value assignment directives
Syntax label = expr

label ALIAS expr

label ASSIGN expr

label DEFINE const_expr
label EQU expr

label SET expr

label SETA expr

label VAR expr

Parameters
const_expr Constant value assigned to symbol.
expr Value assigned to symbol or value to be tested.
label Symbol to be defined.

Description These directives are used for assigning values to symbols:
Directive Description
=, EQU Assigns a permanent value local to a module.
ALIAS Assigns a permanent value local to a module.

ASSIGN, SET, SETA, VAR  Assigns a temporary value.

DEFINE Defines a file-wide value.

Table 19: Value assignment directives

Defining a temporary value

Use ASSIGN, SET, or VAR to define a symbol that might be redefined, such as for use
with macro variables. Symbols defined with ASSIGN, SET, or VAR cannot be declared
PUBLIC.

This example uses SET to redefine the symbol cons in a loop to generate a table of the
first 8 powers of 3:

name table
cons set 1
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; Generate table of powers of 3.

cr_tabl macro times
dc32 cons

cons set cons * 3
if times > 1
cr_tabl times - 1
endif
endm

section .text:CODE(2)
table cr_tabl 4
end

Defining a permanent local value

Use EQU or = to create a local symbol that denotes a number or offset. The symbol is
only valid in the module in which it was defined, but can be made available to other
modules with a PUBLIC directive (but not with a PUBWEAK directive).

Use EXTERN to import symbols from other modules.

Defining a permanent global value

Use DEFINE to define symbols that should be known to the module containing the
directive. After the DEFINE directive, the symbol is known.

A symbol which was given a value with DEFINE can be made available to modules in
other files with the PUBLIC directive.

Symbols defined with DEFINE cannot be redefined within the same file. Also, the
expression assigned to the defined symbol must be constant.

Conditional assembly directives
Syntax ELSE
ELSEIF condition
ENDIF

IF condition

Parameters
condition One of these:
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Example
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An absolute expression The expression must not contain
forward or external references, and
any non-zero value is considered as
true.

stringl=string2 The conditionis true if stringl and
string2 have the same length and

contents.

stringl<>string2 The condition is true if stringl and
string2 have different length or
contents.

Use the IF, ELSE, and ENDIF directives to control the assembly process at assembly
time. If the condition following the IF directive is not true, the subsequent instructions
do not generate any code (that is, it is not assembled or syntax checked) until an ELSE
or ENDIF directive is found.

Use ELSEIF to introduce a new condition after an IF directive. Conditional assembly
directives can be used anywhere in an assembly, but have their greatest use in
conjunction with macro processing.

All assembler directives (except for END) as well as the inclusion of files can be disabled
by the conditional directives. Each IF directive must be terminated by an ENDIF
directive. The ELSE directive is optional, and if used, it must be inside an IF. . .ENDIF
block. IF...ENDIF and IF...ELSE. . .ENDIF blocks can be nested to any level.

This example uses a macro to add a constant to a register:

?add macro a,b,c
if _args == 2
adds a,a, #b
elseif _args == 3
adds a,b,#c
endif
endm
name addwithMacro
section MYCODE:CODE (2)
arm
main ?add rl, OXFF ; This,
?add rl,rl, OXFF ; and this,
adds rl,rl, #0xFF ; are the same as this.
end
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Macro processing directives

Syntax

Parameters

Description
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_args

ENDM

ENDR

EXITM

LOCAL symbol [, symbol]

name MACRO [argument] [,argument]

REPT expr

REPTC formal,actual

REPTI formal,actual [,actuall]

actual
argument
expr

formal

name

symbol

Strings to be substituted.
Symbolic argument names.
An expression.

An argument into which each character of actual (REPTC) or each
string of actual (REPTI) is substituted.

The name of the macro.

Symbols to be local to the macro.

These directives allow user macros to be defined. For information about the restrictions
that apply when using a directive in an expression, see Expression restrictions, page 34.

Directive Description Expression restrictions
_args Is set to number of arguments passed to macro.

ENDM Ends a macro definition.

ENDR Ends a repeat structure.

EXITM Exits prematurely from a macro.

LOCAL Creates symbols local to a macro.

MACRO Defines a macro.

Table 20: Macro processing directives



Assembler directives ___¢

Directive Description Expression restrictions

REPT Assembles instructions a specified number of times. No forward references
No external references
Absolute
Fixed

REPTC Repeats and substitutes characters.

REPTI Repeats and substitutes text.

Table 20: Macro processing directives (Continued)

A macro is a user-defined symbol that represents a block of one or more assembler
source lines. Once you have defined a macro, you can use it in your program like an
assembler directive or assembler mnemonic.

When the assembler encounters a macro, it looks up the macro’s definition, and inserts
the lines that the macro represents as if they were included in the source file at that
position.

Macros perform simple text substitution effectively, and you can control what they
substitute by supplying parameters to them.

The macro process consists of three distinct phases:

1 The assembler scans and saves macro definitions. The text between MACRO and
ENDM is saved but not syntax checked. Include-file references $ £i1le are recorded
and included during macro expansion.

2 A macro call forces the assembler to invoke the macro processor (expander). The
macro expander switches (if not already in a macro) the assembler input stream
from a source file to the output from the macro expander. The macro expander takes
its input from the requested macro definition.

The macro expander has no knowledge of assembler symbols since it only deals with
text substitutions at source level. Before a line from the called macro definition is
handed over to the assembler, the expander scans the line for all occurrences of
symbolic macro arguments, and replaces them with their expansion arguments.

3 The expanded line is then processed as any other assembler source line. The input
stream to the assembler continues to be the output from the macro processor, until
all lines of the current macro definition have been read.

Defining a macro

You define a macro with the statement:

name MACRO [argument] [,argument]

Here name is the name you are going to use for the macro, and argument is an argument
for values that you want to pass to the macro when it is expanded.
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For example, you could define a macro errMacro as follows:

name errMacro

extern abort
errMac macro text

bl abort

data

dc8 text, 0

endm

This macro uses a parameter text (passed in LR) to set up an error message for a routine
abort. You would call the macro with a statement such as:

section MYCODE:CODE (2)
arm
errMac 'Disk not ready'

The assembler expands this to:

section MYCODE:CODE (2)

arm
bl abort

data

dc8 'Disk not ready',O0
end

If you omit a list of one or more arguments, the arguments you supply when calling the
macro are called \1 to \9 and \A to \Z.

The previous example could therefore be written as follows:

name errMacro

extern abort
errMac macro text

bl abort

data

dc8 \1,0

endm

Use the EXITM directive to generate a premature exit from a macro.
EXITM is not allowed inside REPT...ENDR, REPTC...ENDR, Oor REPTI...ENDR blocks.

Use LOCAL to create symbols local to a macro. The LocAL directive must be used before
the symbol is used.

Each time that a macro is expanded, new instances of local symbols are created by the
LocaL directive. Therefore, it is legal to use local symbols in recursive macros.

Note: It is illegal to redefine a macro.
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Macro arguments that include commas or white space can be forced to be interpreted as
one argument by using the matching quote characters < and > in the macro call.

For example:

cmp_reg

name cmpMacro
macro op

CMP op

endm

The macro can be called using the macro quote characters:

section MYCODE:CODE(2)
cmp_reg <r3,r4d>
end

You can redefine the macro quote characters with the -M command line option, see -M,

page 61.

Predefined macro symbols

The symbol _args is set to the number of arguments passed to the macro. This example
shows how _args can be used:

fill

macro

if _args == 2
rept \2

dc8 \1

endr

else

dc8 \1

endif

endm

module filler
section .text:CODE(2)
fill 3

fill 4, 3

end
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It generates this code:

19 module fill

20 section .text:CODE(2)
21 £i1l 3

21.1 if _args ==
21.2 rept

21.3 dc8 3

21.4 endr

21.5 else

21 00000000 03 £i1l 3

21.1 endif

21.2 endm

22 £i1l 4, 3
22.1 if _args ==
22.2 rept 3

22.3 dc8 4

22.4 endr

22 00000001 04 dc8 4

22 00000002 04 dc8 4

22 00000003 04 dcs8 4

22.1 else

22.2 dc8 4

22.3 endif

22.4 endm

23 end

Repeating statements
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Use the REPT. . . ENDR structure to assemble the same block of instructions several
times. If expr evaluates to 0 nothing is generated.

Use REPTC to assemble a block of instructions once for each character in a string. If the
string contains a comma it should be enclosed in quotation marks.

Double quotes have a special meaning—their only use is to enclose the characters to
iterate over. Single quotes have no special meaning and are treated as ordinary
characters.

Use REPTT to assemble a block of instructions once for each string in a series of strings.
Strings containing commas should be enclosed in quotation marks.
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This example assembles a series of calls to a subroutine plotc to plot each character in
a string:

name reptc
extern plotc
section MYCODE:CODE(2)

banner reptc chr, "Welcome"
movs r0,#'chr' ; Pass char as parameter.
bl plotc
endr
end

This produces this code:

9 name reptc

10 extern plotc

11 section MYCODE:CODE(2)

12

13 banner reptc chr, "Welcome"

14 movs r0, #'chr' ; Pass char as
parameter

15 bl plotc

16 endr

16.1 00000000 5700BOE3 movs r0, #'W' ; Pass char as
parameter

16.2 00000004 ........ bl plotc

16.3 00000008 6500BOE3 movs r0,#'e’ ; Pass char
as

16.4 0000000C ........ bl plotc

16.5 00000010 6COOBOE3 movs r0o,#'1" ; Pass char
as parameter.

16.6 00000014 ........ bl plotc

16.7 00000018 6300BOE3 movs r0,#'c’ ; Pass char
as parameter.

16.8 0000001C ........ bl plotc

16.9 00000020 6FO0OBOE3 movs r0,#'o' ; Pass char
as parameter.

16.10 00000024 ........ bl plotc

16.11 00000028 6DO0OBOE3 movs r0,#'m' ; Pass char
as parameter.

16.12 0000002C ........ bl plotc

16.13 00000030 6500BOE3 movs r0,#'e’ ; Pass char
as parameter.

16.14 00000034 ........ bl plotc

17

18 end
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This example uses REPTT to clear several memory locations:

name repti
extern a,b,c
section MYCODE:CODE(2)

clearABC movs r0, #0
repti location,a,b,c
ldr rl,=location
str r0, [rl]
endr
end

This produces this code:

9 name repti

10 extern a,b,c

11 section MYCODE:CODE (2)
12

13 00000000 0000BOE3 clearABC movs r0, #0
14 repti location,a,b,c
15 ldr rl,=location
16 str r0, [rl]

17 endr

17.1 00000004 10109FE5 ldr rl,=a

17.2 00000008 000081E5 str r0, [rl]

17.3 0000000C OC1O09FE5 ldr rl,=b

17.4 00000010 O0OO081E5 str r0, [rl]

17.5 00000014 08109FE5 ldr rl,=c

17.6 00000018 000081E5 str r0, [rl]

18

19 end

Coding inline for efficiency

In time-critical code it is often desirable to code routines inline to avoid the overhead of
a subroutine call and return. Macros provide a convenient way of doing this.
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This example outputs bytes from a buffer to a port:

name ioBufferSubroutine
section MYCODE:CODE (2)
arm
play ldr rl,=buffer ; Pointer to buffer.
ldr r2,=ioPort ; Pointer to ioPort.
ldr r3,=512 ; Size of buffer.
add r3,r3,rl ; Address of first byte
; after buffer.
loop ldrb rd, [rl],#1 ; Read a byte of data, and
strb rd, [r2] ; write it to the ioPort.
cmp rl,r3 ; Reached first byte after?
bne loop ; No: repeat.
bx 1r ; Return.
ioPort equ 0x0100

section MYDATA:DATA (2)
data
buffer ds8 512 ; Reserve 512 bytes.

section MYCODE:CODE (2)

arm
main bl play
done b done
end
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For efficiency we can recode this using a macro:

play

loop

ioPort

buffer

main
done

name ioBufferInline
macro buf, size,port
local loop

1dr rl,=buf ;
1ldr r2,=port ;
ldr r3,=size ;
add r3,r3,rl i
1drb rd, [rl],#1 ;
strb rd, [r2] i
cmp rl, r3 i
bne loop ;
endm

equ 0x0100

section MYDATA:DATA (2)
data

ds8 512 ;
section MYCODE:CODE (2)
arm

play buffer, 512, ioPort
b done

end

Pointer to buffer.
Pointer to ioPort.

Size of buffer.

Address of first byte
after buffer.

Read a byte of data, and
write it to the ioPort.
Reached first byte after?
No: repeat.

Reserve 512 bytes.

Notice the use of the LOCAL directive to make the label 1oop local to the macro—
otherwise an error is generated if the macro is used twice, as the 1oop label already

exists.

Listing control directives

Syntax
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COL columns
LSTCND{+ |-}
LSTCOD{+ |-}
LSTEXP{+|-}
LSTMAC{+ |-}
LSTOUT{+ |-}

LSTPAG{+|-}



Parameters

Description

LSTREP{+|-}
LSTXRF{+|-}
PAGE

PAGSIZ lines
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columns An absolute expression in the range 80 to 132, default is 80

lines An absolute expression in the range 10 to 150, default is 44

These directives provide control over the assembler list file:

Directive Description

CcoL Sets the number of columns per page.
LSTCND Controls conditional assembly listing.
LSTCOD Controls multi-line code listing.

LSTEXP Controls the listing of macro-generated lines.
LSTMAC Controls the listing of macro definitions.
LSTOUT Controls assembly-listing output.

LSTPAG Controls the formatting of output into pages.
LSTREP Controls the listing of lines generated by repeat directives.
LSTXRF Generates a cross-reference table.

PAGE Generates a new page.

PAGSIZ Sets the number of lines per page.

Table 21: Listing control directives

Turning the listing on or off

Use LsTOUT- to disable all list output except error messages. This directive overrides

all other listing control directives.

The default is LsTOUT+, which lists the output (if a list file was specified).

To disable the listing of a debugged section of program:

lstout-

; This section has already been debugged.

lstout+

; This section is currently being debugged.

end

17
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Listing conditional code and strings

Use LSTCND+ to force the assembler to list source code only for the parts of the assembly
that are not disabled by previous conditional IF statements.

The default setting is LSTCND-, which lists all source lines.

Use LSTCOD- to restrict the listing of output code to just the first line of code for a source
line.

The default setting is LSTCOD+, which lists more than one line of code for a source line,
if needed—that is, long ASCII strings produce several lines of output. Code generation
is not affected.

This example shows how LsTCND+ hides a call to a subroutine that is disabled by an IF

directive:
name lstcndTest
extern print
section FLASH:CODE(2)
debug set 0
if debug
bl print
endif
lstcnd+
begin2 if debug
bl print
endif
end

This generates the following listing:

9 name lstcndTest
10 extern print

11 section FLASH:CODE(2)
12

13 debug set 0

14 begin if debug

15 bl print

16 endif

17

18 lstcnd+

19 begin2 if debug

21 endif

22

23 end

IAR Assembler User Guide
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Controlling the listing of macros

Use LSTEXP- to disable the listing of macro-generated lines. The default is LSTEXP+,
which lists all macro-generated lines.

Use LsTMAC+ to list macro definitions. The default is LSTMAC-, which disables the
listing of macro definitions.

This example shows the effect of LSTMAC and LSTEXP:

name lstmacTest
extern memLoc
section FLASH:CODE (2)

dec2 macro arg
subs rl,rl, #arg
subs rl,rl, #arg
endm
lstmac+

inc2 macro arg
adds rl,rl, #arg
adds rl,rl, #arg
endm

begin dec2 memLoc
lstexp-
inc2 memLoc
bx 1r

; Restore default values for
; listing control directives.

lstmac-
lstexp+

end

19
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This produces the following output:

13 name lstmacTest

14 extern memLoc

15 section FLASH:CODE (2)
16

21

22 lstmac+

23 inc2 macro arg

24 adds rl,rl, #arg
25 adds rl,rl, #arg
26 endm

27

28 begin dec2 memLoc

28.1 00000000 ........ subs rl,rl, #memLoc
28.2 00000004 ........ subs rl,rl, #memLoc
28.3 endm

29 lstexp-

30 inc2 memLoc

31 00000010 1EFF2FE1l bx 1r

32

33 ; Restore default values for

34 ; listing control directives.

35

36 lstmac-

37 lstexp+

38

39 end

Controlling the listing of generated lines

Use LSTREP- to turn off the listing of lines generated by the directives REPT, REPTC,
and REPTI.

The default is LSTREP+, which lists the generated lines.

Generating a cross-reference table

Use LSTXRF+ to generate a cross-reference table at the end of the assembler list for the
current module. The table shows values and line numbers, and the type of the symbol.

The default is LSTXRF-, which does not give a cross-reference table.

Specifying the list file format

Use COL to set the number of columns per page of the assembler list. The default number
of columns is 80.

IAR Assembler User Guide
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Use PAGSIZ to set the number of printed lines per page of the assembler list. The default
number of lines per page is 44.

Use LsTPAG+ to format the assembler output list into pages.
The default is LSTPAG-, which gives a continuous listing.

Use PAGE to generate a new page in the assembler list file if paging is active.

C-style preprocessor directives

Syntax #define symbol text
#elif condition
#else
#endif
#error "message"
#if condition
#ifdef symbol
#ifndef symbol
#include {"filename" | <filename>}
#message "message"

#undef symbol

Parameters
condition An absolute assembler expression, see Expressions, operands, and
operators, page 24.
The expression must not contain any assembler labels or symbols,
and any non-zero value is considered as true. The C preprocessor
operator defined can be used.
filename Name of file to be included or referred.
message Text to be displayed.
symbol Preprocessor symbol to be defined, undefined, or tested.
text Value to be assigned.
Description The assembler has a C-style preprocessor that is similar to the C89 standard.
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Note: The preprocessor expressions use the same precedence rules as the assembler
operators.

These C-language preprocessor directives are available:

Directive Description

#define Assigns a value to a preprocessor symbol.

#elif Introduces a new condition in an #if. . .#endif block.
#else Assembles instructions if a condition is false.

#endif Ends an #if, #ifdef, or #ifndef block.

#error Generates an error.

#if Assembles instructions if a condition is true.

#ifdef Assembles instructions if a preprocessor symbol is defined.
#ifndef Assembles instructions if a preprocessor symbol is undefined.
#include Includes a file.

#message Generates a message on standard output.

#pragma This directive is recognized but ignored.

#undef Undefines a preprocessor symbol.

Table 22: C-style preprocessor directives

You must not mix assembler language and C-style preprocessor directives.
Conceptually, they are different languages and mixing them might lead to unexpected
behavior, as an assembler directive is not necessarily accepted as a part of the C
preprocessor language.

Note: The preprocessor directives are processed before other directives. As an example
avoid constructs like:

redef macro ; Avoid the following!
#define \1 \2
endm

because the \1 and \2 macro arguments are not available during the preprocessing
phase.

Defining and undefining preprocessor symbols
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Use #define to define a value of a preprocessor symbol.
#define symbol value

Use #undef to undefine a symbol—the effect is as if it had not been defined.
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Conditional preprocessor directives

Use the #if...#else...#endif directives to control the assembly process at assembly
time. If the condition following the #1i £ directive is not true, the subsequent instructions
will not generate any code (that is, it will not be assembled or syntax checked) until an
#endif or #else directive is found.

All assembler directives (except for END) and file inclusion can be disabled by the
conditional directives. Each #i £ directive must be terminated by an #endi £ directive.
The #else directive is optional and, if used, must be inside an #if...#endif block.

#if..#endif and #if...#else...#endif blocks can be nested to any level.

Use #1ifdef to assemble instructions up to the next #else or #endif directive only if
a symbol is defined.

Use #ifndef to assemble instructions up to the next #else or #endif directive only if
a symbol is undefined.

This example defines the labels tweak and adjust. If adjust is defined, then register
16 is decremented by an amount that depends on adjust, for example 30 when adjust

is 3.

#define
#define

calibrate
#ifdef
#if

#elif

#elif

#endif
#endif

name calibrate
extern calibrationConstant
section MYCODE:CODE(2)

arm

tweak 1

adjust 3

ldr r0,calibrationConstant
tweak

adjust==1

subs r0,r0, #4
adjust==

subs r0,r0, #20
adjust==

subs r0,r0, #30

/* ifdef tweak */

str r0,calibrationConstant
bx 1r
end
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Including source files

Displaying errors
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Use #include to insert the contents of a header file into the source file at a specified
point.

#include " filename" and #include <filename> search these directories in the
specified order:

1 The source file directory. (This step is only valid for #include " filename".)

2 The directories specified by the - T option, or options. The directories are searched
in the same order as specified on the command line, followed by the ones specified
by environment variables.

3 The current directory, which is the same as where the assembler executable file is
located.

4 The automatically set up library system include directories. See -g, page 58.

This example uses #include to include a file defining macros into the source file. For
example, these macros could be defined in Macros. inc:

; Exchange registers a and b.
; Use the register c for temporary storage.

xch macro a,b,c
movs c,a
movs a,b
movs b, c
endm

The macro definitions can then be included, using #include, as in this example:

name includeFile
section MYCODE:CODE(2)
arm

; Standard macro definitions.
#include "Macros.inc"

xchRegs xch r0,rl,r2
bx 1r
end

Use #error to force the assembler to generate an error, such as in a user-defined test.
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Ignoring #pragma

A #pragma line is ignored by the assembler, making it easier to have header files
common to C and assembler.

Comments in C-style preprocessor directives

If you make a comment within a define statement, use:

o the C comment delimiters /* ... */tocomment sections

o the C++ comment delimiter // to mark the rest of the line as comment.

Do not use assembler comments within a define statement as it leads to unexpected
behavior.

This expression evaluates to 3 because the comment character is preserved by #define:

#define x 3 ; This is a misplaced comment.

module misplacedCommentl
expression equ x * 8 + 5

end

This example illustrates some problems that might occur when assembler comments are
used in the C-style preprocessor:

#define five 5 ; This comment is not OK.
#define six 6 // This comment is OK.
#define seven 7 /* This comment is OK. */

module misplacedComment?2
section MYCONST:CONST (2)

DC32 five, 11, 12

; The previous line expands to:

; "DC32 5 ; This comment is not OK., 11, 12"
DC32 six + seven, 11, 12

; The previous line expands to:

; "DC32 6 + 7, 11, 12"
end
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Data definition or allocation directives

Syntax

Parameters

Description
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DC8 expr [,expr]
DCl6 expr [,expr]
DC24 expr [,expr]
DC32 expr [,expr]
DC64 expr [,expr]
DCB expr [,expr]
DCD expr [,expr]
DCQ expr [,expr]
DCW expr [,expr]
DFl6 value [,valuel]
DF32 value [,valuel
DF64 value [,value]
DS count

DS8 count

DS16 count

DS24 count

DS32 count

DS64 count

count A valid absolute expression specifying the number of elements to be
reserved.
expr A valid absolute, relocatable, or external expression, or an ASCII string.

ASCII strings are zero filled to a multiple of the data size implied by the
directive. Double-quoted strings are zero-terminated. For DC64, expr
cannot be relocatable or external.

value A valid absolute expression or floating-point constant.

These directives define values or reserve memory.

Use DC8, DC16, DC24, DC32, DC64, DCB, DCD, DCQ, DCW, DF16, DF32, Or DF64 to create
a constant, which means an area of bytes is reserved big enough for the constant.

Use DS8, DS16, DS24, DS32, or DS64 to reserve a number of uninitialized bytes.

For information about the restrictions that apply when using a directive in an expression,
see Expression restrictions, page 34.
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The column Alias in the following table shows the Arm Limited directive that
corresponds to the IAR directive.

Directive Alias Description

DC8 DCB Generates 8-bit constants, including strings.
DC16 DCW Generates |6-bit constants.

DC24 Generates 24-bit constants.

DC32 DCD Generates 32-bit constants.

DC64 DCQ Generates 64-bit constants.

DF16 Generates |6-bit floating-point constants.
DF32 Generates 32-bit floating-point constants.
DF64 Generates 64-bit floating-point constants.
DS8 DS Allocates space for 8-bit integers.

DS16 Allocates space for 16-bit integers.

DS24 Allocates space for 24-bit integers.

DS32 Allocates space for 32-bit integers.

DS64 Allocates space for 64-bit integers.

Table 23: Data definition or allocation directives

Note: Relocatable expressions cannot be used in a DC8 directive.
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Generating a lookup table
This example sums up the entries of a constant table of 8-bit data.

module sumTableAndIndex
section MYDATA:CONST

data

table dc8 12
dc8 15
dc8 17
dc8 16
dc8 14
dc8 11
dc8 9

section MYCODE:CODE(2)

arm
count set 0
addTable movs r0, #0
ldr rl,=table
rept 7
if count == 7
exitm
endif
1ldrb r2, [rl, #count]
adds r0,r0,r2
count set count + 1
endr
bx 1r
end

Defining strings
To define a string:
myMsg DC8 'Please enter your name'
To define a string which includes a trailing zero:
myCstr DC8 "This is a string."
To include a single quote in a string, enter it twice, for example:

errMsg DC8 'Don''t understand!'

IAR Assembler User Guide
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To reserve space for 10 bytes:

table DS8 10

Assembler control directives

Syntax

Parameters

Description

$ filename

/* comment*/

// comment
CASEOFF

CASEON

INCLUDE filename
LTORG

RADIX expr

comment
expr

filename

Comment ignored by the assembler.
Default base—default 10 (decimal).

Name of file to be included.

These directives provide control over the operation of the assembler. For information
about the restrictions that apply when using a directive in an expression, see Expression

restrictions, page 34.

Directive Description Expression restrictions
$ Includes a file.

/*comment*/ C-style comment delimiter.

// C++ style comment delimiter.

CASEOFF Disables case sensitivity.

CASEON Enables case sensitivity.

INCLUDE Includes a file.

Table 24: Assembler contro

[ directives
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Directive Description Expression restrictions
LTORG Directs the current literal pool to be
assembled immediately after the
directive.
RADIX Sets the default base on all numeric No forward references
values. No external references
Absolute
Fixed

Table 24: Assembler control directives (Continued)

Use $ to insert the contents of a file into the source file at a specified point. $ £1i1ename
is an alias for #include " filename", see the section Including source files under
C-style preprocessor directives, page 121. The $ character must be the first character on
the line.

Use /*...*/ to comment sections of the assembler listing.
Use // to mark the rest of the line as comment.

Use INCLUDE to insert the contents of a file into the source file at a specified point.
INCLUDE filenameis an alias for #include <filename>, see the section Including
source files under C-style preprocessor directives, page 121. Note that INCLUDE only
searches in the system header directories.

Use LTORG to direct where the current literal pool is to be assembled. By default, this is
performed at every END and RSEG directive. For an example, see LDR (ARM), page 146.

Use RADIX to set the default base for constants. The default base is 10.

Controlling case sensitivity
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Use CASEON or CASEOFF to turn case sensitivity on or off for user-defined symbols. By
default, case sensitivity is off.

When CASEOFF is active all symbols are stored in upper case, and all symbols used by
ILINK should be written in upper case in the ILINK definition file.

When CASEOFF is set, label and LABEL are identical in this example:

module caseSensitivityl
section MYCODE:CODE(2)

caseoff

label nop ; Stored as "LABEL".
b LABEL
end
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The following will generate a duplicate label error:

module caseSensitivity?2

caseoff

label nop ; Stored as "LABEL".

LABEL nop ; Error, "LABEL" already defined.
end

Including a source file

This example uses $ to include a file defining macros into the source file. For example,
these macros could be defined in Macros . inc:

; Exchange registers a and b.
; Use register c¢ for temporary storage.

xch macro a,b,c
movs c,a
movs a,b
movs b, c
endm

The macro definitions can be included with a $ directive, as in:

name includeFile
section MYCODE:CODE(2)

; Standard macro definitions.
$Macros.inc

xchRegs xch r0,rl,r2
bx 1r
end

Defining comments
This example shows how /*. .. */ can be used for a multi-line comment:

/*

Program to read serial input.
Version 1: 19.2.11

Author: mjp

*/

See also the section Comments in C-style preprocessor directives under C-style
preprocessor directives, page 121.
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Changing the base

Function directives

Syntax

Parameters

Description

Example

See also
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To set the default base to 16:

module radix
section MYCODE:CODE(2)

radix 16 ; With the default base set

movs r0, #12 ; to 16, the immediate value

Pe.. ; of the mov instruction is
; interpreted as 0x12.

; To reset the base from 16 to 10 again, the argument must be
; written in hexadecimal format.

radix 0x0a ; Reset the default base to 10.
movs r0, #12 ; Now, the immediate value of
P ; the mov instruction is

; interpreted as 0x0Oc.
end

CALL_GRAPH_ROOT function [,category]

function The function, a symbol.

category An optional call graph root category, a string.

Use this directive to specify that, for stack usage analysis purposes, the function
functionis a call graph root. You can also specify an optional category, a quoted
string.

The compiler will generate this directive in assembler list files, when needed.
CALL_GRAPH_ROOT my_interrupt, "interrupt"

Call frame information directives for stack usage analysis, page 139, for information
about CFI directives required for stack usage analysis.

IAR C/C++ Development Guide for Arm for information about how to enable and use
stack usage analysis.
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Call frame information directives for names blocks

Syntax Names block directives:
CFI NAMES name
CFI ENDNAMES name
CFI RESOURCE resource : bits [, resource : bits]
CFI VIRTUALRESOURCE resource : bits [, resource : bits]

CFI RESOURCEPARTS resource part, part [, part] ...

CFI STACKFRAME cfa resource type [, cfa resource typel]
CFI BASEADDRESS cfa type [, cfa typel
Parameters

bits The size of the resource in bits.

cfa The name of a CFA (canonical frame address).

name The name of the block.

namesblock The name of a previously defined names block.

offset The offset relative the CFA. An integer with an optional sign.

part A part of a composite resource. The name of a previously
declared resource.

resource The name of a resource.

size The size of the frame cell in bytes.

type The segment memory type, such as CODE, CONST, or DATA. In
addition, any of the memory types supported by the IAR ILINK
Linker. It is only used for denoting an address space.

Description Use these directives to define a names block:

Directive Description

CFI BASEADDRESS Declares a base address CFA (Canonical Frame Address).

CFI ENDNAMES Ends a names block.

CFI FRAMECELL Creates a reference into the caller’s frame.

CFI NAMES Starts a names block.

CFI RESOURCE Declares a resource.

Table 25: Call frame information directives names block
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Example

See also

Directive

Description

CFI RESOURCEPARTS Declares a composite resource.

CFI STACKFRAME

Declares a stack frame CFA.

CFI VIRTUALRESOURCE Declares a virtual resource.

Table 25: Call frame information directives names block (Continued)

Examples of using CFI directives, page 44

Tracking call frame usage, page 37

Call frame information directives for common blocks

Syntax

Parameters
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Common block directives:

CFI COMMON name USING namesblock

CFI ENDCOMMON name

CFI CODEALIGN codealignfactor

CFI DATAALIGN dataalignfactor

CFI DEFAULT { UNDEFINED | SAMEVALUE }

CFI RETURNADDRESS resource type

codealignfactor

commonblock

dataalignfactor

name
namesblock

resource

The smallest common factor of all instruction sizes. Each CFI
directive for a data block must be placed according to this
alignment. 1 is the default and can always be used, but a larger
value reduces the produced call frame information in size. The
possible range is 1-256.

The name of a previously defined common block.

The smallest common factor of all frame sizes. If the stack
grows toward higher addresses, the factor is negative; if it grows
toward lower addresses, the factor is positive. 1 is the default, but
a larger value reduces the produced call frame information in
size. The possible ranges are —256 to —1 and 1 to 256.

The name of the block.
The name of a previously defined names block.

The name of a resource.
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type The memory type, such as CODE, CONST, or DATA. In addition,
any of the segment memory types supported by the IAR ILINK
Linker. It is only used for denoting an address space.

Description Use these directives to define a common block:
Directive Description
CFI CODEALIGN Declares code alighment.
CFI COMMON Starts or extends a common block.
CFI DATAALIGN Declares data alignment.
CFI DEFAULT Declares the default state of all resources.
CFI ENDCOMMON Ends a common block.
CFI RETURNADDRESS Declares a return address column.

Table 26: Call frame information directives common block

In addition to these directives you might also need the call frame information directives
for specifying rules, or CFI expressions for resources and CFAs, see Call frame
information directives for tracking resources and CFAs, page 136.

Example Examples of using CFI directives, page 44

See also Tracking call frame usage, page 37

Call frame information directives for data blocks

Syntax CFI BLOCK name USING commonblock
CFI ENDBLOCK name
CFI { NOFUNCTION | FUNCTION label }
CFI { INVALID | VALID }

CFI { REMEMBERSTATE | RESTORESTATE }

CFI PICKER
CFI CONDITIONAL label [, labell
Parameters
commonblock The name of a previously defined common block.
label A function label.
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Description

Example

See also

name

The name of the block.

These directives allow call frame information to be defined in the assembler source

code:

Directive Description

CFI BLOCK Starts a data block.

CFI CONDITIONAL Declares a data block to be a conditional thread.

CFI ENDBLOCK Ends a data block.

CFI FUNCTION Declares a function associated with a data block.

CFI INVALID Starts a range of invalid call frame information.

CFI NOFUNCTION Declares a data block to not be associated with a function.

CFI PICKER Declares a data block to be a picker thread. Used by the
compiler for keeping track of execution paths when code
is shared within or between functions.

CFI REMEMBERSTATE Remembers the call frame information state.

CFI RESTORESTATE Restores the saved call frame information state.

CFI VALID Ends a range of invalid call frame information.

Table 27: Call frame information directives for data blocks

In addition to these directives, you might also need the call frame information directives
for specifying rules, or CFI expressions for resources and CFAs, see Call frame
information directives for tracking resources and CFAs, page 136.

Examples of using CFI directives, page 44

Tracking call frame usage, page 37

Call frame information directives for tracking resources and CFAs

Syntax

IAR Assembler User Guide
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CFI

CFI

CFI

CFI

CFI

cfa { resource | resource + constant | resource - constant }

cfa cfiexpr

resource { UNDEFINED | SAMEVALUE | CONCAT }

resource { resource | FRAME (cfa, offset) }

resource cfiexpr
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Parameters
cfa The name of a CFA (canonical frame address).
cfiexpr A CFI expression, which can be one of these:
o A CFI operator with operands
® A numeric constant
o A CFA name
e A resource name.

constant A constant value or an assembler expression that can be

evaluated to a constant value.

offset The offset relative the CFA. An integer with an optional sign.

resource The name of a resource.

Unary operators Overall syntax: OPERATOR (operand)

CFIl operator Operand Description

COMPLEMENT cfiexpr Performs a bitwise NOT on a CFl expression.

LITERAL expr Get the value of the assembler expression. This can insert
the value of a regular assembler expression into a CFl
expression.

NOT cfiexpr Negates a logical CFl expression.

UMINUS cfiexpr Performs arithmetic negation on a CFl expression.

Table 28: Unary operators in CFI expressions

Binary operators Overall syntax: OPERATOR (operandl, operand2)

CFl operator Operands Description

ADD cfiexpr,cfiexpr Addition

AND cfiexpr,cfiexpr Bitwise AND

DIV cfiexpr,cfiexpr Division

EQ cfiexpr,cfiexpr Equal to

GE cfiexpr,cfiexpr Greater than or equal to

GT cfiexpr,cfiexpr Greater than

LE cfiexpr,cfiexpr Less than or equal to

LSHIFT cfiexpr,cfiexpr Logical shift left of the left operand. The number of

bits to shift is specified by the right operand. The sign
bit will not be preserved when shifting.

Table 29: Binary operators in CFI expressions
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Ternary operators
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CFl operator Operands

Description

LT cfiexpr,cfiexpr
MOD cfiexpr,cfiexpr
MUL cfiexpr,cfiexpr
NE cfiexpr,cfiexpr
OR cfiexpr,cfiexpr

RSHIFTA cfiexpr,cfiexpr

RSHIFTL cfiexpr,cfiexpr

SUB cfiexpr,cfiexpr

XOR cfiexpr,cfiexpr

Less than
Modulo
Multiplication
Not equal to
Bitwise OR

Arithmetic shift right of the left operand. The
number of bits to shift is specified by the right
operand. In contrast with RSHIFTL, the sign bit is
preserved when shifting.

Logical shift right of the left operand. The number of
bits to shift is specified by the right operand. The sign
bit will not be preserved when shifting.

Subtraction

Bitwise XOR

Table 29: Binary operators in CFI expressions (Continued)

Overall syntax: OPERATOR (operandl, operand2, operand3)

Operator Operands

Description

FRAME cfa,size,offset

IF cond, true, false

LOAD size, type,addr

Gets the value from a stack frame. The operands are:
cfa, an identifier that denotes a previously declared CFA.
s1ize, a constant expression that denotes a size in bytes.
of fset,a constant expression that denotes a size in bytes.
Gets the value at address cfa+offset of size size.

Conditional operator. The operands are:

cond, a CFl expression that denotes a condition.

true, any CFl expression.

false, any CFl expression.

If the conditional expression is non-zero, the result is the
value of the true expression; otherwise the result is the
value of the false expression.

Gets the value from memory. The operands are:

Size, a constant expression that denotes a size in bytes.
type, a memory type.

addr, a CFl expression that denotes a memory address.
Gets the value at address addr in the segment memory
type type of size size.

Table 30: Ternary operators in CFI expressions
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Description Use these directives to track resources and CFAs in common blocks and data blocks:
Directive Description
CFI cfa Declares the value of a CFA.
CFI resource Declares the value of a resource.

Table 31: Call frame information directives for tracking resources and CFAs
Example Examples of using CFI directives, page 44

See also Tracking call frame usage, page 37

Call frame information directives for stack usage analysis

Syntax CFI FUNCALL { caller } callee
CFI INDIRECTCALL { caller }
CFI NOCALLS { caller }

CFI TAILCALL { callee }

Parameters
callee The label of the called function.
caller The label of the calling function.

Description These directives allow call frame information to be defined in the assembler source
code:
Directive Description
CFI FUNCALL Declares function calls for stack usage analysis.
CFI INDIRECTCALL Declares indirect calls for stack usage analysis.
CFI NOCALLS Declares absence of calls for stack usage analysis.
CFI TAILCALL Declares tail calls for stack usage analysis.
Table 32: Call frame information directives for stack usage analysis

See also Tracking call frame usage, page 37

The IAR C/C++ Development Guide for Arm for information about stack usage
analysis.
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Assembler
pseudo-instructions

The IAR Assembler for Arm accepts a number of pseudo-instructions, which
are translated into correct code. This chapter lists the pseudo-instructions
and gives examples of their use.

Summary

In the following table, as well as in the following descriptions:

e ARM denotes pseudo-instructions available after the ARM directive
e CODE16* denotes pseudo-instructions available after the CODE16 directive
e THUMB denotes pseudo-instructions available after the THUMB directive.

The properties of THUMB pseudo-instructions depend on whether the used core has the
Thumb-2 instruction set or not.

Note: In Thumb mode (and CODE16), the syntax LDR register, =expression can,
for values from O to 255, be translated into a MOVS instruction. This instruction modifies
the program status register.

This is a summary of the available pseudo-instructions for the A32 and T32 instruction
sets:

Pseudo-instruction Directive Translated to Description

ADR ARM ADD, SUB Loads a program-relative address
into a register.

ADR CODEl6* ADD Loads a program-relative address
into a register.

ADR THUMB ADD, SUB Loads a program-relative address
into a register.

ADRL ARM ADD, SUB Loads a program-relative address
into a register.
ADRL THUMB ADD, SUB Loads a program-relative address

into a register.

LDR ARM MOV, MVN, LDR Loads a register with any 32-bit
expression.

Table 33: Pseudo-instructions for A32 and T32
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Pseudo-instruction Directive  Translated to Description

LDR CODE16* MOV, MOVS, LDR Loads a register with any 32-bit
expression.

LDR THUMB MOV, MOVS, MVN, LDR  Loads a register with any 32-bit
expression.

MOV CODEl6* ADD Moves the value of a low register
to another low register (RO—R7).

MOV32 THUMB MOV, MOVT Loads a register with any 32-bit
value.

NOP ARM MOV Generates the preferred Arm

no-operation code.

NOP CODE16* MOV Generates the preferred Thumb
no-operation code.

Table 33: Pseudo-instructions for A32 and T32 (Continued)

* Deprecated. Use THUMB instead.

This is a summary of the available pseudo-instructions for the A64 instruction set:

Pseudo-instruction Translated to Description

ADRL ADRP, ADD Loads a program-relative address into a
register.

LDR LDR Loads a register with any 32-bit expression.

MOVL MOVZ(, MOVK) Loads a register with a 32-bit or 64-bit value.

Table 34: Pseudo-instructions for A64

Descriptions of pseudo-instructions

The following section gives reference information about each pseudo-instruction.

ADR (ARM)

Syntax ADR{condition} register,expression

Parameters
{condition}  Canbe one of the following—EQ, NE, CS, CC, MI, PL, VS, VC, HI, LS,
GE, LT, GT, LE, and AL.

register The register to load.

IAR Assembler User Guide
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Description

ADR (CODE I 6)

Syntax

Parameters

Description

ADR (THUMB)

Syntax

Parameters

Assembler pseudo-instructions ___¢

expression A program location counter-relative expression that evaluates to an
address that is not word-aligned within the range -247 to +263 bytes,
or a word-aligned address within the range -1012 to +1028 bytes.
Unresolved expressions (for example expressions that contain
external labels, or labels in other sections) must be within the range
-247 to +263 bytes.

ADR always assembles to one instruction. The assembler attempts to produce a single
ADD or SUB instruction to load the address:

name armAdr
section MYCODE:CODE (2)
arm
adr r0, thumbLabel ; Becomes "add r0,pc, #1".
bx r0
thumb
thumbLabel ;
end

ADR register, expression

register The register to load.

expression A program-relative expression that evaluates to a word-aligned
address within the range +4 to +1024 bytes.

This Thumb-1 ADR can generate word-aligned addresses only (that is, addresses
divisible by 4). Use the ALTIGNROM directive to ensure that the address is aligned (unless
DC32 is used, because it is always word-aligned).

ADR{condition} register,expression

{condition}  An optional condition code if the instruction is placed after an IT
instruction.
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Description

Example

See also

ADRL (64-bit mode)

Syntax

Parameters

Description
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register The register to load.

A program-relative expression that evaluates to an address within
the range -4095 to 4095 bytes.

expression

Similar to ADR (CODEL16), but the address range can be larger if a 32-bit Thumb-2
instruction is available in the architecture used.

If the address offset is positive and the address is word-aligned, the 16-bit ADR
(CODE16) version will be generated by default.

The 16-bit version can be specified explicitly with the ADR . N instruction. The 32-bit
version can be specified explicitly with the ADR . w instruction.

name thumbAdr
section MYCODE:CODE(2)
thumb
adr r0,dataLabel ; Becomes "add r0,pc, #4".
add r0,r0,rl
bx 1r
data
alignrom 2
dataLabel dc32 0xABCD19
end

ADR (CODE]I6), page 143 if only 16-bit Thumb instructions are available.

ADRL register,expression

register The register to load, X0-x30.

A program-relative expression that evaluates to an address within
the range -4 Gbytes to +4 Gbytes from the instruction.

expression

The ADRL pseudo-instruction loads a program-relative address into a register. It is
similar to the ADR instruction. ADRL can load a wider range of addresses than ADR
because it generates two data processing instructions. The assembler will not attempt to
determine if the expression is within range. If the address is not within the range

-4 Gbytes to +4 Gbytes, the linker will generate an error message and linking will fail.



ADRL (ARM)

Syntax

Parameters

Description

Example

ADRL (THUMB)

Syntax

Parameters
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ADRL{condition} register,expression

{condition} Can be one of the following—EQ, NE, CS, CC, MI, PL, VS, VC, HI, LS,
GE, LT, GT, LE, and AL.

register The register to load.

expression A register-relative expression that evaluates to an address that is not
word-aligned within 64 Kbytes, or a word-aligned address within
256 Kbytes. Unresolved expressions (for example expressions that
contain external labels, or labels in other sections) must be within 64
Kbytes. The address can be either before or after the address of the
instruction.

The ADRL pseudo-instruction loads a program-relative address into a register. It is
similar to the ADR pseudo-instruction. ADRL can load a wider range of addresses than
ADR because it generates two data processing instructions. ADRL always assembles to
two instructions. Even if the address can be reached in a single instruction, a second,
redundant instruction is produced. If the assembler cannot construct the address in two
instructions, it generates an error message and the assembly fails.

name armAdrL
section MYCODE:CODE(2)
arm
adrl rl,label+0x2345 ; Becomes "add rl,pc, #0x45"
; and "add rl,rl,#0x2300"
data
label dc32 0
end

ADRL{condition} register,expression

{condition}  An optional condition code if the instruction is placed after an IT
instruction.

register The register to load.
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LDR (64-bit mode)
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Parameters

Description

LDR (ARM)

Syntax

Parameters

Description
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A program-relative expression that evaluates to an address within
the range + 1 Mbyte.

expression

Similar to ADRL (ARM), but the address range can be larger. This instruction is only
available in a core supporting the Thumb-2 instruction set.

LDR register,=expression

register The register to load, X0—-x30 or WO—wW30.

Any 32-bit or 64-bit expression. A 64-bit expression can be
loaded into x0—x3 0 and a 32-bit expression can be loaded into
wO0-w30.

expression

The LDR pseudo-instruction loads a register with any 32-bit or 64-bit expression. The
assembler places the constant in a literal pool and generates a program-relative LDR
instruction that reads the constant from the literal pool. The offset from the instruction
to the constant must be within the range -1 Mbyte to +1 Mbyte.

LDR{condition} register,=expressionl
or

LDR{condition} register,expression2

condition An optional condition code.

register The register to load.
expressionl Any 32-bit expression.
expression2 A program location counter-relative expression in the range

-4087 to +4103 from the program location counter.

The first form of the LDR pseudo-instruction loads a register with any 32-bit expression.
The second form of the instruction reads a 32-bit value from an address specified by the
expression.
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If the value of expressionl is within the range of a MOV or MVN instruction, the
assembler generates the appropriate instruction. If the value of expressionl is not
within the range of a MOV or MVN instruction, or if the expressionl is unsolved, the
assembler places the constant in a literal pool and generates a program-relative LDR
instruction that reads the constant from the literal pool. The offset from the program
location counter to the constant must be less than 4 Kbytes.

Example name armLdr
section MYCODE:CODE(2)
arm
ldr rl,=0x12345678 ; Becomes "ldr rl, [pc,#4]":

; loads 0x12345678 from the
; literal pool.

ldr r2,label ; Becomes "ldr r2, [pc,#-4]1":
; loads OXFFEEDDCC into r2.

data
label dc32 0xFFEEDDCC
ltorg ; The literal pool is placed
; here.
end
See also The LTORG directive in the section Assembler control directives, page 129.
LDR (CODEI6)
Swnax LDR register, =expressionl
or
LDR register, expression2
Parameters
register The register to load. LDR can access the low registers (R0—R7) only.
expressionl  Any 32-bit expression.
expression2 A program location counter-relative expression +4 to +1024 from
the program location counter.
Description As in Arm mode, the first form of the LDR pseudo-instruction in Thumb mode loads a

register with any 32-bit expression. Note that the first form can be translated into a MOvVS
instruction, which modifies the program status register.

The second form of the instruction reads a 32-bit value from an address specified by the
expression. However, the offset from the program location counter to the constant must
be positive and less than 1 Kbyte.
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LDR (THUMB)

Syntax

Parameters

Description

Example
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LDR{condition} register,=expression

condition An optional condition code if the instruction is placed after an
IT instruction.

register The register to load.

expression Any 32-bit expression.

Similar to the LDR (CODE16) instruction, but by using a 32-bit instruction, a larger
value can be loaded directly with a MOV or MVN instruction without requiring the constant
to be placed in a literal pool.

By specitying a 16-bit version explicitly with the LDR . N instruction, a 16-bit instruction
is always generated. This may lead to the constant being placed in the literal pool, even
though a 32-bit instruction could have loaded the value directly using MOV or MVN.

By specitying a 32-bit version explicitly with the LDR . w instruction, a 32-bit instruction
is always generated.

If you do not specify either .N or .w, the 16-bit LDR (CODE16) instruction will be
generated, unless Rd is R8-R15, which leads to the 32-bit variant being generated.

As for LDR (CODE16), the 16-bit variant can be translated into a MOVS instruction,
which modifies the program status register.

Note: The syntax LDR{condition} register, expression2,asdescribed for LDR
(ARM) and LDR (CODELG6), is no longer considered a pseudo-instruction. It is part of

the normal instruction set as specified in the Unified Assembler syntax from Advanced
RISC Machines Ltd.

name thumbLdr
extern extLabel



See also

MOV (CODEI6)

Syntax

Parameters

Description

Example
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section MYCODE:CODE(2)

thumb
1ldr rl,=extLabel ; Becomes "ldr rl, [pc,#8]1":
nop ; loads extLabel from the
; literal pool.
1ldr r2,label ; Becomes "ldr r2, [pc,#0]":
nop ; loads OxXFFEEDDCC into r2.
data
label dc32 0xXFFEEDDCC
ltorg ; The literal pool is placed
; here.
end

LDR (CODEI6), page 147 if only 16-bit Thumb instructions are available.

MOV Rd, Rs

RA The destination register.

Rs The source register.

The Thumb MoV pseudo-instruction moves the value of a low register to another low
register (RO-R7) . The Thumb MOV instruction cannot move values from one low register
to another.

Note: The ADD immediate instruction generated by the assembler has the side-effect of
updating the condition codes.

The MOV pseudo-instruction uses an ADD immediate instruction with a zero immediate
value.

Note: This description is only valid when using the CODE16 directive. After the THUMB
directive, the interpretation of the instruction syntax is defined by the Unified Assembler
syntax from Advanced RISC Machines Ltd.

MOV r2,r3 ; generates the opcode for ADD r2,r3,#0
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MOV32 (THUMB)

Syntax

Parameters

Description

MOVL (64-bit mode)

Syntax

Parameters

Description

NOP (ARM)

Syntax

Description
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MOV32{condition} register, expression

condition An optional condition code if the instruction is placed after an IT

instruction.
register The register to load.
expression Any 32-bit expression.

Similar to the LDR (THUMB) instruction, but will load the constant by generating a pair
of the MOV (MOVW) and the MOVT instructions.

This pseudo-instruction always generates two 32-bit instructions. It is only available in
a core supporting the Thumb-2 instruction set.

MOVL register, #expression
register The register to load, X0—x30 or WO—wW30.

Any 32-bit or 64-bit expression. A 64-bit expression can be loaded
into Xx0—x30 and a 32-bit expression can be loaded into w0-w30.

expression

Similar to the LDR pseudo-instruction, but will load the constant by generating a pair of
a MOV instruction and a MOVK instruction (for a 32-bit expression), or a MOV instruction
and three MOVK instructions (for a 64-bit expression). Unresolved expressions are not
supported.

NOP

NOP generates the preferred Arm no-operation code:
MOV r0,r0

Note: NOP is not a pseudo-instruction in architecture versions that include a NOP
instruction (Armv6K, Armv6T2, Armv7, Armv8-M).
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NOP (CODEI6)

Syntax NOP
Description NOP generates the preferred Thumb no-operation code:
MOV r8,r8

Note: NOP is not a pseudo-instruction in architecture versions that include a NOP
instruction (Armv6T2, Armv7, Armv8-M).
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Assembler diagnostics

The following pages describe the format of diagnostic messages, and explains
how diagnostic messages are divided into different levels of severity.

Message format

All diagnostic messages are displayed on the screen, and printed in the optional list file.

All messages are issued as complete, self-explanatory messages. The message consists
of the incorrect source line, with a pointer to where the problem was detected, followed
by the source line number and the diagnostic message. If include files are used, error
messages are preceded by the source line number and the name of the current file:

"subfile.h",4 Error[40]: bad instruction

Severity levels

The diagnostic messages produced by the IAR Assembler for Arm reflect problems or
errors that are found in the source code or occur at assembly time.

OPTIONS FOR DIAGNOSTICS

There are two assembler options for diagnostics. You can:

e Disable or enable all warnings, ranges of warnings, or individual warnings, see -w,
page 68

o Set the number of maximum errors before the assembly stops, see -E, page 55.

ASSEMBLER WARNING MESSAGES

Assembler warning messages are produced when the assembler finds a construct which
is probably the result of a programming error or omission.

COMMAND LINE ERROR MESSAGES

Command line errors occur when the assembler is invoked with incorrect parameters.
The most common situation is when a file cannot be opened, or with duplicate,
misspelled, or missing command line options.
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ASSEMBLER ERROR MESSAGES

Assembler error messages are produced when the assembler finds a construct which
violates the language rules.

ASSEMBLER FATAL ERROR MESSAGES

Assembler fatal error messages are produced when the assembler finds a user error so
severe that further processing is not considered meaningful. After the diagnostic
message is issued, the assembly is immediately ended. These error messages are
identified as Fatal in the error messages list.

ASSEMBLER INTERNAL ERROR MESSAGES

An internal error is a diagnostic message that signals that there was a serious and
unexpected failure due to a fault in the assembler.

During assembly, several internal consistency checks are performed and if any of these
checks fail, the assembler terminates after giving a short description of the problem.
Such errors should normally not occur. However, if you should encounter an error of this
type, it should be reported to your software distributor or to IAR Technical Support.
Please include information enough to reproduce the problem. This would typically
include:

o The product name

o The version number of the assembler, which can be seen in the header of the list
files generated by the assembler

Your license number
The exact internal error message text

The source file of the program that generated the internal error

A list of the options that were used when the internal error occurred.



Migrating to the IAR
Assembler for Arm

Assembler source code that was originally written for assemblers from other
vendors can also be used with the IAR Assembler for Arm. The assembler
option -j allows you to use a number of alternative register names, mnemonics
and operators.

This chapter contains information that is useful when migrating from using an
existing product to using the IAR Assembler for Arm in 32-bit mode.

Introduction

The IAR Assembler for Arm (IASMARM) was designed using the same look and feel
as other IAR assemblers, while still making it easy to translate source code written for
the ARMASM assembler from Arm Limited.

When the option -3 (Allow alternative register names, mnemonics and operands) is
selected, the instruction syntax is the same in IASMARM as in ARMASM. Many
features, such as directives and macros, are, however, incompatible and cause syntax
errors. There are also differences in Thumb code labels that can cause problems without
generating errors or warnings. Be extra careful when you use such labels in situations
other than jumps.

For new code, use the AR Assembler for Arm register names, mnemonics and
operators.

Note: The instructions and descriptions in this chapter apply only to using the IAR
Assembler for Arm in 32-bit mode.

THUMB CODE LABELS

Labels placed in Thumb code, i.e. that appear after a CODE16 directive, always have bit
0 set (i.e. an odd label) in IASMARM. ARMASM, on the other hand, does not set bit O
on symbols in expressions that are solved at assembly time. In the following example,
the symbol T is local and placed in Thumb code. It will have bit 0 set when assembled
with JASMARM, but not when assembled with ARMASM—except in DCD, since it is
solved at link time for relocatable sections. Thus, the instructions will be assembled
differently.
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Example

section MYCODE:CODE(2)
arm

The two instructions below are interpreted differently by ARMASM and IASMARM.
ICCARM interprets a reference to T as an odd address (with the Thumb mode bit set),
but in ARMASM it is even (the Thumb mode bit is not set).

adr r0,T+1
mov rl, #T7-.

To achieve the same interpretation for both ARMASM and ICCARM, use :OR: to set
the Thumb mode bit, or : AND: to clear it:

add r0,pc, #(T-.-8) :0R: 1
mov rl,#(T-.) :AND: ~1
thumb

T nop
end

Alternative register names

IAR Assembler User Guide
for Arm

The IAR Assembler for Arm will translate the register names below used in other
assemblers when the option -3 is selected. These alternative register names are allowed
in both Arm and Thumb modes. The following table lists alternative register names and
assembler register names:

Alternative register name Assembler register name
Al RO
A2 R1
A3 R2
A4 R3
Vi R4
V2 R5
V3 R6
V4 R7
V5 R8
V6 R9
V7 R10
SB R9

Table 35: Alternative register names
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Alternative register name Assembler register name
SL R10
FP R11
IP R12

Table 35: Alternative register names (Continued)

For further descriptions of the registers, see Register symbols, page 27.

Alternative mnemonics

A number of mnemonics used by other assemblers will be translated by the assembler
when the option -J is specified. These alternative mnemonics are allowed in CODE16
mode only. The following table lists the alternative mnemonics:

Alternative mnemonic Assembler mnemonic
ADCS ADC
ADDS ADD
ANDS AND
ASLS LSL
ASRS ASR
BICS BIC
BNCC BCS
BNCS BCC
BNEQ BNE
BNGE BLT
BNGT BLE
BNHI BLS
BNLE BGT
BNLO BCS
BNLS BHI
BNLT BGE
BNMI BPL
BNNE BEQ
BNPL BMI
BNVC BVS

Table 36: Alternative mnemonics
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Alternative mnemonic Assembler mnemonic
BNVS BVC
CMN{cond}S CMN{cond}
CMP{cond}S CMP{cond}
EORS EOR

LSLS LSL

LSRS LSR

MOVS MOV

MULS MUL

MVNS MVN

NEGS NEG

ORRS ORR

RORS ROR

SBCS SBC

SUBS SUB
TEQ{cond}S TEQ{cond}
TST{cond}S TST{cond}

Table 36: Alternative mnemonics (Continued)

Refer to the ARM Architecture Reference Manual (Prentice-Hall) for full descriptions of
the mnemonics.

Operator synonyms

A number of operators used by other assemblers will be translated by the assembler
when the option -7 is specified. The following operator synonyms are allowed in both
Arm and Thumb modes:

Operator synonym Assembler operator
:AND: &

:EOR: ~

:LAND: &&

:LEOR: XOR

:LNOT: 1

:LOR: |

:MOD: %

Table 37: Operator synonyms

IAR Assembler User Guide
158 for Arm



Migrating to the IAR Assembler for Arm °

Operator synonym Assembler operator
:NOT: ~

:OR: |

:SHL: <<

:SHR: >>

Table 37: Operator synonyms (Continued)

Note: In some cases, assembler operators and operator synonyms have different
precedence levels. For further descriptions of the operators, see the chapter Assembler
operators, page 73.

Warning messages

Unless the option -7 is specified, the assembler will issue warning messages when the
alternative names are used, or when illegal combinations of operands are encountered.
The following sections list the warning messages:

THE FIRST REGISTER OPERAND OMITTED

The first register operand was missing in an instruction that requires three operands,
where the first two are unindexed registers (ADD, SUB, LSL, LSR, and ASR).

THE FIRST REGISTER OPERAND DUPLICATED

The first register operand was a register that was included in the operation, and was also
a destination register.

Example of incorrect code:
MUL RO, RO, R1
Example of correct code:

MUL RO, R1

IMMEDIATE #0 OMITTED IN LOAD/STORE
Immediate #0 was missing in a load/store instruction.
Example of incorrect code:

LDR RO, [R1]

Example of correct code:

LDR RO, [R1,#0]
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